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About this document

The IBM(R) WebSphere(R) Business Integration Adapter portfolio supplies
integration connectivity for leading e-business technologies, enterprise applications,
legacy, and mainframe systems. The product set includes tools and templates for
customizing, creating, and managing components for business process integration.

This document describes the installation, configuration, and business object
development for the adapter for WebSphere Integration Message Broker.

Audience

This document is for consultants, developers, and system administrators who
support and manage the WebSphere business integration product at customer sites.

Prerequisites for this document

Users of this document should be familiar with the WebSphere business integration
system, with business object and collaboration development, and with the
WebSphere Integration Message Broker application.

Related documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Adapters
installations, and includes reference material on specific components.

This document contains many references to two other documents: the System
Installation Guide for Windows or for UNIX and the System Implementation Guide for
WebSphere InterChange Server. If you choose to print this document, you may want
to print these documents as well.

You can install related documentation from the following sites:

¢ For general adapter information; for using adapters with WebSphere message
brokers (WebSphere MQ Integrator, WebSphere MQ Integrator Broker,
WebSphere Business Integration Message Broker); and for using adapters with
WebSphere Application Server:

[http:/ /www.ibm.com /websphere/integration/wbiadapters/infocenter|

* For using adapters with InterChange Server:

http:/ /www.ibm.com /websphere/integration /wicserver/ infocenteﬂ

http:/ /www.ibm.com /websphere /integration/ wbicollaborations /infocenter|

¢ For more information about message brokers (WebSphere MQ Integrator Broker,
WebSphere MQ Integrator, and WebSphere Business Integration Message
Broker):
|http: / /www.ibm.com/software/integration/mgqfamily/library /manualsa/ |

e For more information about WebSphere Application Server:
[http:/ /www.ibm.com /software/webservers/appserv/library.html|

These sites contain simple directions for downloading, installing, and viewing the
documentation.

© Copyright IBM Corp. 2000, 2004 \%
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Note: Important information about this product may be available in Technical
Support Technotes and Flashes issued after this document was published.
These can be found on the WebSphere Business Integration Support Web
site, http://www.ibm.com/software/integration/websphere/support/.
Select the component area of interest and browse the Technotes and Flashes
sections. Additional information might also be available in IBM Redbooks at
http:/ /www.redbooks.ibm.com/.

Typographic conventions

vi

This document uses the following conventions:

courier font

bold
italic, italic
blue outline

[]

/I\

%text% and $text

ProductDir

Indicates a literal value, such as a command name, filename,
information that you type, or information that the system
prints on the screen.

Indicates a new term the first time that it appears.

Indicates a variable name or a cross-reference.

A blue outline, which is visible only when you view the
manual online, indicates a cross-reference hyperlink. Click
inside the outline to jump to the object of the reference.

In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.1og.

In this document, backslashes (\) are used as the convention
for directory paths. For UNIX installations, substitute slashes
(/) for backslashes. All product pathnames are relative to the
directory where the product is installed on your system.
Text within percent (%) signs indicates the value of the
Windows text system variable or user variable. The
equivalent notation in a UNIX environment is $text,
indicating the value of the text UNIX environment variable.
Represents the directory where the product is installed.

Adapter for WebSphere Business Integration Message Broker User Guide



New in this release

New in release 2.6.x

Two connector-specific properties have been added: EnableMessageProducerCache
and SessionPoolSizeForRequests. For more information, see |Apper1dix B,|
[“Connector-specific properties for the WBI Message Broker adapter,” on page 81

The adapter has been rebranded from the Adapter for WebSphere MQ Integrator
Broker to the Adapter for WebSphere Integration Message Broker.

As of version 2.6.x, the adapter is not supported on Solaris 7, so references to that
platform version have been deleted from this guide.

New in release 2.5.x

The connector now runs on the following platforms:
* Microsoft Windows 2000
* Solaris 7, 8 or AIX 5.1, 5.2 or HP UX 11.i

Beginning with the 2.5.0 version, the adapter for WebSphere MQ is no longer
supported on Microsoft Windows NT.

Adapter installation information has been moved from this guide. See Chapter 2
for the new location of that information.

New in release 2.4.x

The adapter can now use WebSphere Application Server as an integration broker.
For further information, see [“Broker compatibility” on page 11|

The connector now runs on the following platforms:
* Microsoft Windows NT 4.0 Service Pack 6A or Windows 2000
e Solaris 7, 8 or AIX 5.1, 5.2 or HP UX 11.i

New in release 2.3.x

Updated in March, 2003. The "CrossWorlds” name is no longer used to describe an
entire system or to modify the names of components or tools, which are otherwise
mostly the same as before. For example "CrossWorlds System Manager” is now
"System Manager,” and "CrossWorlds InterChange Server” is now "WebSphere
InterChange Server.”

You can now associate a data handler with an input queue. For further
ﬁormation, see|“Overview of mapping data handlers to input queues” on page|

The adapter now supports the WebSphere MQ Event Broker as well as the
WebSphere MQ Integrator Broker and the WebSphere InterChange Server
integration brokers.

© Copyright IBM Corp. 2000, 2004 vii



The guaranteed event delivery feature has been enhanced. For further information,
see ["Guaranteeing event delivery” on page 35.|

New in release 2.2.x

The InProgress queue is no longer required and may be disabled. For more
information, see|“InProgressQueue” on page 85.|

The connector supports interoperability with applications via MQSeries 5.1, 5.2,
and 5.3. For more information, see [“Adapter dependencies” on page 12.|

The connector now has a UseDefaults property for business object processing. For
more information, see[“UseDefaults” on page 85

The connector can now apply a default verb when the data handler does not

explicitly assign one to a business object. For more information, see [“DefaultVerb’
ﬁ

The ReplyToQueue can now be dictated via the dynamic child meta-object rather
than by the ReplyToQueue connector property. For more information see
lheaders and dynamic child meta-object attributes” on page 54.|

You can use a message selector to identify, filter and otherwise control how the
adapter identifies the response message for a given request. This JMS capability
applies to synchronous request processing only. For more information, see
[“Synchronous delivery” on page 5.

New in release 2.1.x

The connector has been internationalized. For more information, see |“TasE|
roadmap” on page 1| and|Appendix A, “Standard configuration properties for]
connectors,” on page 63/

This guide provides information about using this adapter with ICS.

Note: To use the guaranteed event delivery feature, you must install release 4.1.1.2
of ICS.

New in release 1.5.x

viii

The IBM WebSphere Business Integration Adapter for MQ Integrator includes the
connector for MQ Integrator. This adapter operates with the InterChange Server
(ICS) integration broker. An integration broker, which is an application that
performs integration of heterogeneous sets of applications, provides services that
include data routing. The adapter includes:

* An application component specific to MQ Integrator

* Sample business objects

* IBM WebSphere Adapter Framework, which consists of:
— Connector Framework

— Development tools (including Business Object Designer and IBM CrossWorlds
System Manager)

— APIs (including CDK)

This manual provides information about using this adapter with ICS.

Adapter for WebSphere Business Integration Message Broker User Guide



Important: Because the connector has not been internationalized, do not run it

against ICS version 4.1.1 if you cannot guarantee that only ISO Latin-1
data will be processed.

The connector has been enabled for the IBM CrossWorlds 4.1.x system.

New in release 1.4.x

In the 1.4.x release of this document, minor changes were made to fix defects and
to provide compatibility with IBM CrossWorlds infrastructure release version 4.0.0.

New in release 1.3.x

The 1.3.x release of this document contains information for the following new
features and product enhancements:

Support for synchronous request and response handling to confirm Create,
Update and Delete operations.

Support for Retrieve, Retrieve By Content, and Exist operations.

Full archiving of messages, including successfully processed and unsubscribed
messages as well as those containing errors.

Enhanced capability to assign the same message format to more than one
business object.

The connector can now identify local queues without requiring a fully-qualified
URI. Accordingly, the "URI" suffix is no longer part of the following connector
properties: InputQueueURI, InProgressQueueURI, UnsubscribedURI, and
ErrorQueueURI.

Additional default conversion properties in the connector meta-object.
Accordingly, the connector property DefaultOutputQueueURI has been removed.

New in this release  1X
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Chapter 1. Overview

* |"Task roadmap”|

* |“Terminology”

+ |“Overview of the adapter environment” on page 3

This chapter provides an overview, explaining terms you need to know and
describing adapter processing. It is important that you understand the adapter
before installing, configuring, and using it.

Task roadmap

To use the Adapter for WebSphere Business Integration Message Broker, you must
perform the tasks described in

Table 1. Using the adapter: task roadmap

Task

Associated procedure(s) (see...)

For more information (see...)

Installing the
connector

Chapter 2, “Installing the|

connector,” on page 11|

Installation Guide for WebSphere
Business Integration Adapters

Configuring business

Chapter 5, “Creating objects,” on|

Business Object Development

Guide
Data Handler Guide

[page 4§|

Chapter 6, “Configuring a datal
handler,” on page 57|

and meta- objects

Configuring a data
handler

Appendix A, “Standard|
configuration properties for]
connectors,” on page
63JAppendix B)
“Connector-specific properties|
for the WBI Message Broker|
adapter,” on page 81| Connector
Development Guide

Chapter 3, “Configuring thel
connector,” on page 17]

Configuring the
connector

Chapter 4, “Running the|
connector,” on page 37|

Running the
connector

Chapter 7, “Troubleshooting,” on|
page 61]

Running the tutorial |[Appendix C, “Tutorial,” on page 87|

Troubleshooting the
connector

Terminology

To understand the adapter, you must understand these terms:

adapter
The component in the WebSphere business integration system that
provides components to support communication between an integration
broker and either an application or a technology. An adapter always
includes a connector, message files, and configuration tools. It can also
include an Object Discovery Agent (ODA). Some adapters also may require
a data handler.

adapter framework
The software that IBM provides to configure and run an adapter. The
runtime components of the adapter framework include the Java runtime

© Copyright IBM Corp. 2000, 2004 1



environment, the connector framework, and the Object Discovery Agent
(ODA) runtime. This connector framework includes the connector libraries
(C++ and Java) needed to develop new connectors. The ODA runtime
includes the library in the Object Development Kit (ODK) needed to
develop new ODAs. The configuration components include the following
tools:

* Business Object Designer,
* Connector Configurator,
* Log Viewer,

* System Manager,

* Adapter Monitor,

* Test Connector

 and, optionally, any Object Discovery Agents (ODAs) associated with an
adapter.

Adapter Development Kit (ADK)
A development kit that provides some samples for adapter development,
including sample connectors and Object Discovery Agents (ODAs).

connector
The component of an adapter that uses business objects to send
information about an event to an integration broker (event notification) or
receive information about a request from the integration broker (request
processing). A connector consists of the connector framework and the
connector’s application-specific component.

connector framework
The component of a connector that manages interactions between a
connector’s application-specific component and the integration broker. This
component provides all required management services and retrieves the
meta-data that the connector requires from the repository. The connector
framework, whose code is common to all connectors, is written in Java and
includes a C++ extension to support application-specific components
written in C++.

connector controller
The subcomponent of the connector framework that interacts with
collaborations. A connector controller runs within InterChange Server and
initiates mapping between application-specific and generic business objects,
and manages collaboration subscriptions to business object definitions.

integration broker
The component in the WebSphere business integration system that
integrates data among heterogeneous applications. An integration broker
typically provides a variety of services that include: the ability to route
data, a repository of rules that govern the integration process, connectivity
to a variety of applications, and administrative capabilities that facilitate
integration. Examples of integration brokers: the WebSphere Business
Integration Message Broker; WebSphere Business InterChange Server.

WebSphere business integration system
An enterprise solution that moves information among diverse sources to
perform business exchanges, and that processes and routes information
among disparate applications in the enterprise environment. The business
integration system consists of an integration broker and one or more
adapters.

2 Adapter for WebSphere Business Integration Message Broker User Guide



WebSphere Integration Message Broker, Version 2.2
A message broker product that transforms and routes messages between
WebSphere MQ queues. The technology enables applications to
communicate asynchronously by delivering messages to and receiving
messages from potentially remote queues. A major change with WebSphere
Integration Message Broker is the addition of message flows that add the
ability to format, store, and route messages based on user-defined logic.

Overview of the adapter environment

shows the adapter, its components, and their relationships within the
WebSphere business integration system. The illustration shows a typical
configuration. The adapter is configured to exchange messages with a legacy
application whose messages flow through the WebSphere Business Integration
Message Broker, and to exchange business objects with InterChange Server. The
connector is metadata-driven. Message routing and format conversion is initiated
by an event polling technique. The connector uses an MQ implementation of the
Java™ Message Service (JMS), an API for accessing enterprise-messaging systems.

Adapter for
WebSphere
Business
Integration

Message
Broker
[}

WebSphere Business Integration

=)
@
3
tegacy \ | Message Broker g \4 pollingthread
queue / X S [
Optional Inbound = 23
s convert to ueue S j (0]
mor a £ message Data busObyj Q& %
"1 handler L 5
Lega:;yl/ app o8
=]
Q
4 Message flows g 8)
KNG g0
% [}
Qo ) message Dat busObj = é
Optional: Outbound ata |— =
convert queue handler
from XML

Legacy A
in queue

Figure 1. Adapter in the WBI environment

The connector allows collaborations to asynchronously exchange business objects
with applications that issue or receive WebSphere MQ messages when changes to

data occur.

The connector retrieves WebSphere MQ messages from queues, calls data handlers
to convert messages to their corresponding business objects, and then delivers
them to collaborations. In the opposite direction, the connector receives business
objects from collaborations, converts them into WebSphere MQ messages using the
same data handler, and then delivers the message to a WebSphere MQ queue.

Recommendation: You can configure the connector to use any data handler when
processing messages. However, since the WebSphere Integration Message Broker
can optionally convert any parsable message into XML format, it is highly
recommended that you configure the connector to deliver all messages in XML.
This means implementing the XML data handler for processing. For an overview
and procedure, see [“Overview of configuring the data handler” on page 57

Chapter 1. Overview 3



Overview of adapter processing

The adapter makes use of IBM’s WebSphere MQ implementation of the Java
Message Service (JMS). The JMS is an open-standard API for accessing
enterprise-messaging systems. It is designed to allow business applications to
asynchronously send and receive business data and events.

The adapter does not directly interact with WBI Message Broker. As part of
configuring the connector, you set up WebSphere MQ queues as the input and
output nodes for the WBI Message Broker message flows. The adapter
communicates with a WebSphere MQ queue manager that hosts the message
broker to which the message flows are deployed.

Message request

illustrates a message request communication for the connector, the
adapter’s runtime component. When the doVerbFor() method receives a business
object from a collaboration, the connector passes the business object to the data
handler. The data handler converts the business object into a suitable message and
issues it to a queue. There, the JMS layer makes the appropriate calls to open a
queue session and route the message. You can configure the connector to issue
requests asynchronously (fire and forget). Or you can configure connector
properties to enable synchronous request processing.

WebSphere
Integration Integration

Output queue Message broker
via JMS service Broker
provider
< | | =) " doVerbFor() | |e
|§| eques Request BO

message

Data
handler

Figure 2. Message request processing

The connector processes business objects passed to it by a collaboration based on
the verb for each business object. The connector uses business object handlers and
the doVerbFor() method to process the business objects that the connector
supports. The connector supports the following business object verbs:

* Create

* Update

e Delete

* Retrieve

* Exists

* Retrieve by Content

Note: Business objects with Create, Update, and Delete verbs can be issued either
asynchronously or synchronously. The default mode is asynchronous. The
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connector does not support asynchronous delivery for business objects with
the Retrieve, Exists, or Retrieve by Content verbs. Accordingly, for Retrieve,
Exists, or Retrieve by Content verbs, the default mode is synchronous.

Create, update, and delete
Processing of business objects with create, update and delete verbs depends on
whether the objects are issued asynchronously or synchronously.

Asynchronous delivery: This is the default delivery mode for business objects
with Create, Update, and Delete verbs. A message is created from the business
object using a data handler and then written to the output queue. If the message is
delivered, the connector returns SUCCESS, else FAIL.

Note: The connector has no way of verifying whether the message is received or if
action has been taken.

Synchronous delivery: If a ReplyToQueue has been defined in the
connector-specific properties and a responseTimeout exists in the meta-object
conversion properties for the business object, the connector issues a request in
synchronous mode. The connector then waits for a response to verify that
appropriate action was taken by the receiving application.

For WebSphere Integration Message Broker, the connector initially issues a message
with a header as shown in

Table 2. Request message descriptor header (MQMD)

Field Description Value

Format Format name Output format as defined in the meta-object conversion properties and
truncated to 8 characters to meet IBM requirements (example: MQSTR)

MsgType Message type MQMT_DATAGRAM=

Report Options for report When a response message is expected, this field is populated as

message requested. follows:MQRO_PAN= to indicate that a positive-action report is required if

processing is successful. MQRO_NAN* to indicate that a negative-action report is
required if processing fails.MQRO_COPY_MSG_ID_TO_CORREL_ID* to indicate that
the correlation ID of the report generated should equal the message ID of the
request originally issued.

ReplyToQ |Name of reply queue | When a response message is expected this field is populated with the value of
connector property ReplyToQueue.

Persistence | Message persistence MQPER_PERSISTENT=*

Expiry Message lifetime MQEI_UNLIMITED*

* Indicates constant defined by IBM.

The message header described in is followed by the message body. The
message body is a business object that has been serialized using the data handler.

The Report field is set to indicate that both positive and negative action reports are
expected from the receiving application. The thread that issued the message waits
for a response message that indicates whether the receiving application was able to
process the request.

When an application receives a synchronous request from the connector, it
Elrocesses the business object and issues a report message as described in@ El and

Chapter 1. Overview 5



Table 3. Response message descriptor header (MQMD)

Field Description Value
Format Format name Input format of busObj as defined in the conversion properties.
MsgType Message type MQMT_REPORT*

*Indicates constant defined by IBM.

Table 4. Population of response message

Verb Feedback field Message body
Create, update, or |SUCCESS (Optional) A serialized business object
delete reflecting changes.

VALCHANGE

VALDUPES (Optional) An error message.

FAIL

Table 5. WebSphere Integration Message Broker feedback codes and WebSphere business integration system

response values

WebSphere Integration Message
Broker feedback code

Equivalent WebSphere business integration system response*

MQFB_PAN or MQFB_APPL_FIRST SUCCESS

MQFB_NAN or MQFB_APPL_FIRST + 1 |FAIL

MQFB_APPL_FIRST + 2 VALCHANGE

MQFB_APPL_FIRST + 3 VALDUPES

MQFB_APPL_FIRST + MULTIPLE_HITS

MQFB_APPL_FIRST + 5 FAIL_RETRIEVE_BY_CONTENT

MQFB_APPL_FIRST + 6 BO_DOES_NOT_EXIST

MQFB_APPL_FIRST + 7 UNABLE_TO_LOGIN (results in immediate termination of connector agent)
MQFB_APPL_FIRST + 8 APP_RESPONSE_TIMEOUT

*See the Connector Development Guide for details.

If the business object can be processed, the application creates a report message
with the feedback field set to MQFB_PAN (or a specific WebSphere business
integration system value). Optionally the application populates the message body
with a serialized business object containing any changes. If the business object
cannot be processed, the application creates a report message with the feedback
field set to MQFB_NAN (or a specific WebSphere business integration system value)
and then optionally includes an error message in the message body. In either case,
the application sets the correlationID field of the message to the messagelD of the
connector message and issues it to the queue specified by the ReplyToQueue field.

Upon retrieval of a response message, the connector by default matches the
correlationID of the response to the messagelD of a request message. The
connector then notifies the thread that issued the request. Depending on the
feedback field of the response, the connector either expects a business object or an
error message in the message body. If a business object was expected but the
message body is not populated, the connector simply returns the same business
object that was originally issued by InterChange Server for the Request operation.

6 Adapter for WebSphere Business Integration Message Broker User Guide




If an error message was expected but the message body is not populated, a generic
error message will be returned to InterChange Server along with the response
code. However, you can also use a message selector to identify, filter and otherwise
control how the adapter identifies the response message for a given request. This
message selector capability is a JMS feature. It applies to synchronous request
processing only and is described below.

Retrieve, exists and retrieve by content: Business objects with the Retrieve,
Exists, and Retrieve By Content verbs support synchronous delivery only. The
connector processes business objects with these verbs as it does for the
synchronous delivery defined for create, update and delete. However, when using
Retrieve, Exists, and Retrieve By Content verbs, the responseTimeout and
replyToQueue are required. Furthermore, for Retrieve By Content and Retrieve
verbs, the message body must be populated with a serialized business object to
complete the transaction.

shows the response messages for these verbs.

Table 6. Population of response message

Verb Feedback field Message body
Retrieve or FAIL (Optional) An error message.
RetrieveByContent | FAIL_RETRIEVE_BY_CONTENT
MULTIPLE_HITS SUCCESS A serialized business object.
Exist FAIL (Optional) An error message.
SUCCESS

Event processing

ﬂlustrates connector event processing. The pol1ForEvents() method
retrieves the next applicable message from the input queue. The message is staged
in the in-progress queue where it remains until processing is complete. Using the
connector meta-object, the connector first determines whether the message type is
supported. If so, the connector passes the message to the configured data handler,
which converts the message into a business object. The verb that is set reflects the
conversion properties established for the message type. The connector then
determines whether the business object is subscribed to by a collaboration. If so,
the gotApplEvents() method delivers the business object to the integration broker,
and the message is removed from the in-progress queue.

For event notification, the connector detects events written to a queue by an
application rather than a database trigger. An event occurs when an application or
other MQ-capable software generates WebSphere MQ messages and stores them on
the MQ message queue.
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Figure 3. Application-connector communication method: Message return

Retrieval
The connector uses the pol1ForEvents() method to poll the MQ queue at regular
intervals for messages. When the connector finds a message, it retrieves it from the
MQ queue and examines it to determine its format. If the format has been defined
in the connector meta-object, the connector uses the data handler to generate an
appropriate business object with a verb. See [‘Overview of error handling” on pagel
39| for event failure scenarios.

The connector processes messages by first opening a transactional session to the
input queue. This transactional approach allows for a small chance that a business
object could be delivered to a collaboration twice due to the connector successfully
submitting the business object but failing to commit the transaction in the queue.
To avoid this problem, the connector moves all messages to an in-progress queue.
There, the message is held until processing is complete. If the connector shuts
down unexpectedly during processing, the message remains in the in-progress
queue instead of being reinstated to the original input queue.

Note: Transactional sessions with a JMS service provider require that every
requested action on a queue be performed and committed before events are
removed from the queue. Accordingly, when the connector retrieves a
message from the queue, it does not commit to the retrieval until three
things occur: 1) The message has been converted to a business object; 2) the
business object is delivered to InterChange Server by the gotApplEvents()
method, and 3) a return value is received.

Recovery

Upon initialization, the connector checks the in-progress queue for messages that
have not been completely processed, presumably due to a connector shutdown.
The connector configuration property InDoubtEvents allows you to specify one of
four options for handling recovery of such messages: fail on startup, reprocess,
ignore, or log error.

Fail on startup: With the fail on startup option, if the connector finds messages in
the in-progress queue during initialization, it logs an error and immediately shuts
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down. It is the responsibility of the user or system administrator to examine the
message and take appropriate action, either to delete these messages entirely or
move them to a different queue.

Reprocess: With the reprocessing option, if the connector finds any messages in
the in-progress queue during initialization, it processes these messages first during
subsequent polls. When all messages in the in-progress queue have been
processed, the connector begins processing messages from the input queue.

Ignore: With the ignore option, if the connector finds any messages in the
in-progress queue during initialization, the connector ignores them, but does not
shut down.

Log error: With the log error option, if the connector finds any messages in the
in-progress queue during initialization, it logs an error but does not shut down.

Archiving

If the connector property ArchiveQueue is specified and identifies a valid queue,
the connector places copies of all successfully processed messages in the archive
queue. If ArchiveQueue is undefined, messages are discarded after processing. For
more information on archiving unsubscribed or erroneous messages, see
[“Overview of error handling” on page 39

Note: By JMS conventions, a retrieved message cannot be issued immediately to
another queue. To enable archiving and re-delivery of messages, the
connector first produces a second message that duplicates the body and the
header (as applicable) of the original. To avoid conflicts with the JMS service
provider, only JMS-required fields are duplicated. Accordingly, the format
field is the only additional message property that is copied for messages
that are archived or re-delivered.
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Chapter 2. Installlng the connector

* |“Adapter environment”

+ [“Overview of installation tasks”|

« |“Verifying installation” on page 13

This chapter describes how to install and configure the connector and how to
configure the message flows to work with the connector.

Overview of installation tasks

To install the adapter for WebSphere Integration Message Broker, you must
perform the following tasks:

* Install the integration broker This task, which includes installing the
WebSphere business integration system and starting the integration broker, is
described in the installation documentation for your broker and operating
system.

 Install the adapter and related files This task includes installing the files for the
adapter from the software package onto your system. See [“Installing the adapter
[and related files” on page 13|

Before installing the adapter, you must understand the adapter environment. For
further information, see [’Adapter environment.”|

In this chapter

The tasks described in this chapter are as follows:

Table 7. Installing the adapter: task roadmap

Task Associated procedure(s) (see...) For more information (see...)

Installing the adapter |“Installing the adapter and related| Installation Guide for WebSphere
files” on page 13| Business Integration Adapters

Verifying installation |“Verifying installation” on page 13|

Adapter environment

Before installing, configuring, and using the adapter, you must understand its
environmental requirements:

+ |“Broker compatibility”]

+ [“Adapter platforms” on page 12|

[“Adapter dependencies” on page 12|

[“Locale-dependent data” on page 13|

Broker compatibility
The adapter framework that an adapter uses must be compatible with the version
of the integration broker (or brokers) with which the adapter is communicating.
The 2.6 version of the adapter for WebSphere Integration Message Broker is
supported on the following adapter framework and integration brokers:

e Adapter framework: WebSphere Business Integration Adapter Framework,
versions:
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- 21

- 22

- 2.3x

- 24

* Integration brokers:

— WebSphere InterChange Server, versions:
- 411
- 42
- 421
- 42x

— WebSphere Application Server Enterprise, version 5.0.2, with WebSphere
Studio Application Developer Integration Edition, version 5.0.1

See the Release Notes for any exceptions.

Note: For instructions on installing the integration broker and its prerequisites, see
the following documentation.

For WebSphere InterChange Server (ICS), see the System Installation Guide for UNIX
or for Windows.

For message brokers (WebSphere Integration Message Broker), see Implementing
Adapters with WebSphere Message Brokers, and the installation documentation for the
message broker. Some of this can be found at the following Web site:

lhttp:/ /www.ibm.com /software/integration /mqfamily /library /manualsa /| For
WebSphere Application Server, see Implementing Adapters with WebSphere Application
Server and the documentation at:

http:/ /www.ibm.com /software /webservers/appserv/library.htm]|

Adapter platforms
The adapter is supported on the following platforms:
* Windows 2000
* AIX 51,52
* Solaris 8
* HP-UX 11i

Adapter dependencies
The adapter has the following software prerequisites and other dependencies:

¢ The connector supports interoperability with applications via WebSphere MQ, or
WebSphere MQ 5.1, 5.2,' and 5.3. Accordingly, you must have one of these
software releases installed.

Note: The adapter does not support Secure Socket Layers (SSL) in WebSphere
MQ 5.3. For the WebSphere MQ software version appropriate to adapter
framework-integration broker communication, see the Installation Guide
for your platform (Windows/Unix).

* In addition, you must have the IBM WebSphere MQ Java client libraries.

1. If your environment implements the convert-on-the-get methodology for character-set conversions you must download the latest
MAS88 (JMS classes) from IBM. The patch level should be at least 5.2.2 (for WebSphere MQ version 5.2). Doing so may avoid
unsupported encoding errors.
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Locale-dependent data

The connector has been internationalized so that it can support double-byte
character sets, and deliver message text in the specified language. When the
connector transfers data from a location that uses one character code to a location
that uses a different code set, it performs character conversion to preserves the
meaning of the data.

The Java runtime environment within the Java Virtual Machine (JVM) represents
data in the Unicode character code set. Unicode contains encoding for characters in
most known character code sets (both single-byte and multibyte). Most
components in the WebSphere business integration system are written in Java.
Therefore, when data is transferred between most integration components, there is
no need for character conversion.

To log error and informational messages in the appropriate language and for the
appropriate country or territory, configure the Locale standard configuration
property for your environment. For more information on configuration properties,
see[Appendix A, “Standard configuration properties for connectors,” on page 63

Installing the adapter and related files

Before you begin: Review the requirements, dependencies, and broker
compatibilities for the adapter. For further information see [“Adapter environment”]
_

For information on installing WebSphere Business Integration adapter products,
refer to the Installation Guide for WebSphere Business Integration Adapters, located in
the WebSphere Business Integration Adapters Infocenter at the following site:

http:/ /www.ibm.com /websphere/integration/wbiadapters/infocenter

Verifying installation

The sections below describe the paths and filenames of the product after
installation and how to verify your adapter installation.

Overview of verifying installation on a Windows system

Before you begin: Install the adapter. The Installer copies the standard files
associated with the adapter into your system. The utility installs the connector into
the ProductDir\connectors\WBIMB directory, and adds a shortcut for the connector
to the Start menu.

Steps for verifying installation on a Windows system
Perform the following step to verify adapter installation on a Windows system:

¢ Change to the directory where you installed the adapter ProductDir\ and
compare the contents to those listed in

describes the Windows file structure used by the adapter, and shows the

files that are automatically installed when you choose to install the adapter
through Installer.
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Table 8. Installed Windows file structure for the adapter

Subdirectory of ProductDir
connectors\WebSphereBIMessageBroker\CWWebSphereBIMessageBroker. jar

connectors\WebSphereBIMessageBroker\start_WebSphereBIMessageBroker.bat
connectors\messages\WebSphereBIMessageBrokerConnector. txt
bin\Data\App\WebSphereBIMessageBrokerConnectorTemplate
connectors\WebSphereBIMessageBroker\samples\LegacyItem\WBIMBConnector.cfg

connectors\WebSphereBIMessageBroker\samples\LegacyItem\PortConnector.cfg

connectors\WebSphereBIMessageBroker\samples\LegacyItem\Sample WBIMB LegacyItem.xsd
connectors\WebSphereBIMessageBroker\samples\LegacyItem\
Sample_WBIMB_LegacyItem_XMLDoc.xsd
connectors\WebSphereBIMessageBroker\samples\LegacyItem\ Sample WBIMB MO Config.xsd
connectors\WebSphereBIMessageBroker\samples\LegacyItem\

Sample_WBIMB_MO DataHandler.xsd
connectors\WebSphereBIMessageBroker\samples\LegacyItem\
Sample_WBIMB_MO_DataHandler_XMLConfig.xsd
connectors\WebSphereBIMessageBroker\samples\LegacyItem\LegacyItem.txt

connectors\WebSphereBIMessageBroker\samples\Legacyltem\mgsiput.exe

connectors\WebSphereBIMessageBroker\samples\LegacyItem\Sample WBIMB Project\
.project
connectors\WebSphereBIMessageBroker\samples\LegacyItem\Sample WBIMB Project\
LocalDomain.configmgr
connectors\WebSphereBIMessageBroker\samples\LegacyItem\Sample WBIMB Project\
Sample_WBIMB_bar.bar
connectors\WebSphereBIMessageBroker\samples\LegacyItem\MSG_FLOW_RPOJECT\ .project
connectors\WebSphereBIMessageBroker\samples\LegacyItem\MSG_FLOW_RPOJECT\
AdjustFormat.esql
connectors\WebSphereBIMessageBroker\samples\LegacyItem\MSG_FLOW_RPOJECT\
Check_CoTor.esql
connectors\WebSphereBIMessageBroker\samples\LegacyItem\MSG_FLOW_RPOJECT\
From_LegacyApplication_to_WBI.msgflow
connectors\WebSphereBIMessageBroker\samples\LegacyItem\MSG_FLOW_RPOJECT\
From_WBI_to_LegacyApplication.msgflow
connectors\WebSphereBIMessageBroker\samples\LegacyItem\MSG_FLOW_RPOJECT\
Loopback.msgflow

Description

Contains classes used by the
WebSphere Business Integration
Message Broker connector agent only
The startup script for the connector
Message file for the connector
Template file for the adapter definition
Sample WBIMB adapter configuration
file

Sample port connector configuration
file

Sample business object repository file
Sample business object repository file

Sample connector agent meta-object
Sample data handler top level
meta-object

Sample meta-object for xml
datahandler configuration

Sample input file for using the
samples

Sample utility for WebSphere MQ to
use with the samples

Sample WBIMB project

Sample Message Flow project

Note: All product pathnames are relative to the directory where the product is

installed on your system.

Overview of verifying installation on a UNIX system

Before you begin: Install the adapter. The Installer copies the standard files
associated with the adapter into your system. The utility installs the connector
agent into the ProductDir/connectors/WBIMB directory.

Steps for verifying installation on a UNIX system

Perform the following step to verify adapter installation on a UNIX system:

* Change to the directory where you installed the adapter ProductDir/ and

compare the contents to those listed in

describes the UNIX file structure used by the adapter, and shows the files
that are automatically installed when you choose to install the adapter through

Installer.
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Table 9. Installed UNIX file structure for the connector

Subdirectory of ProductDir
connectors/WebSphereBIMessageBroker/CWWebSphereBIMessageBroker. jar

connectors/WebSphereBIMessageBroker/start_WebSphereBIMessageBroker.sh
connectors/messages/WebSphereBIMessageBrokerConnector. txt
bin/Data/App/WebSphereBIMessageBrokerConnectorTemplate
connectors/WebSphereBIMessageBroker/samples/Legacyltem/WBIMBConnector.cfg

connectors/WebSphereBIMessageBroker/samples/LegacyItem/PortConnector.cfg

connectors/WebSphereBIMessageBroker/samples/Legacyltem/
Sample_WBIMB_LegacylItem.xsd
connectors/WebSphereBIMessageBroker/samples/Legacyltem/

Sample_WBIMB_LegacyItem XMLDoc.xsd
connectors/WebSphereBIMessageBroker/samples/Legacyltem/ Sample_WBIMB_MO_Config.xsd
connectors/WebSphereBIMessageBroker/samples/Legacyltem/
Sample_WBIMB_MO_DataHandler.xsd
connectors/WebSphereBIMessageBroker/samples/Legacyltem/
Sample_WBIMB_MO_DataHandler_XMLConfig.xsd
connectors/WebSphereBIMessageBroker/samples/Legacyltem/Legacyltem.txt

connectors/WebSphereBIMessageBroker/samples/Legacyltem/mgsiput.exe

connectors/WebSphereBIMessageBroker/samples/Legacyltem/Sample WBIMB Project/
.project
connectors/WebSphereBIMessageBroker/samples/LegacyItem/Sample_WBIMB_Project/
LocalDomain.configmgr
connectors/WebSphereBIMessageBroker/samples/LegacyItem/Sample_WBIMB Project/
Sample_WBIMB bar.bar
connectors/WebSphereBIMessageBroker/samples/Legacyltem/MSG_FLOW_RPOJECT /.project
connectors/WebSphereBIMessageBroker/samples/LegacyItem/MSG_FLOW_RPOJECT\
AdjustFormat.esql
connectors/WebSphereBIMessageBroker/samples/Legacyltem/MSG_FLOW_RPOJECT/
Check_Color.esq]
connectors/WebSphereBIMessageBroker/samples/LegacyItem/MSG_FLOW_RPOJECT/
From_LegacyApplication_to_WBI.msgflow
connectors/WebSphereBIMessageBroker/samples/LegacyItem/MSG_FLOW_RPOJECT/
From WBI_to_LegacyApplication.msgflow
connectors/WebSphereBIMessageBroker/samples/Legacyltem/MSG_FLOW_RPOJECT/
Loopback.msgf1low

Description

Contains classes used by the
WebSphere Business Integration
Message Broker connector agent only
System startup script for the connector.
Message file for the connector
Template file for the adapter definition
Sample WBIMB adapter configuration
file

Sample port connector configuration
file

Sample business object repository file

Sample business object repository file

Sample connector agent meta-object
Sample datahandler top level
meta-object

Sample meta-object for xml
datahandler configuration

Sample input file for using the
samples

Sample utility for WebSphere MQ to
use with the samples

Sample WBIMB project

Sample Message Flow project

Note: All product pathnames are relative to the directory where the product is

installed on your system.
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Chapter 3. Conflgurlng the connector

“Overview of Connector Configurator” on page 18|

* |“Starting Connector Configurator” on page 19

» |“Creating a connector-specific property template” on page 20|

+ [“Creating a new configuration file” on page 22|

* |“Using an existing file” on page 23

» [“Setting the configuration file properties” on page 25|

* [“Saving your configuration file” on page 30|

. "’Changmg a configuration file” on page 31

* [“Completing the configuration” on page 31

« [“Using Connector Configurator in a globalized environment” on page 31|

* [“Verifying a sample configuration” on page 33|

* |“Creating multiple connector instances” on page 32|

* |“Setting Queue Uniform Resource Identifiers (URI)” on page 33|

This chapter describes how to use Connector Configurator to set configuration
property values for your adapter.

Overview of configuring the connector

You configure the connector using Connector Configurator and other tools. You use
Connector Configurator to do the following:

* Create a connector-specific property template for configuring your connector
* Create a configuration file
* Set properties in a configuration file

Note:
In this document, backslashes (\) are used as the convention for directory
paths. For UNIX installations, substitute slashes (/) for backslashes and
follow the conventions for each operating system.

You also use Connector Configurator when creating multiple instances of a
connector.

See the task roadmap for additional configuration procedures covered in this
chapter.

In this chapter

This tasks described in this chapter are as follows:

Table 10. Configuring the connector: task roadmap

Task Associated procedure(s) (see...) For more information (see...)
Starting Connector “Starting Connector Configurator”|

Configurator on page 19

Creating a “Creating a connector-specifid

connector-specific property template” on page 20|

property template
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Table 10. Configuring the connector: task roadmap (continued)

Task

Associated procedure(s) (see...) For more information (see...)

Creating a
configuration file

“Creating a new configuration file”|

on page 22|

Setting configuration
properties

“Setting the configuration file|

properties” on page 25|

Saving a
configuration file

“Saving your configuration file” on|

)
[¢)
@

Changing a
configuration file

“Changing a configuration file” on|

age 31

Verifying the
configuration

“Completing the configuration” on|

e 31

()

Localizing a
configuration

“Using Connector Configurator in al

olobalized environment” on pagel

31

Creating multiple
connector instances

“Creating multiple connector]|

instances” on page 32|

Verifying a sample
configuration

“Verifying a sample configuration”|

on page 33|

Setting Queue URIs

“Setting Queue Uniform Resource]

Identifiers (URI)” on page 33|

Using guaranteed
event delivery

“Guaranteeing event delivery” on|

[page 35

Overview of Connector Configurator

Connector Configurator allows you to configure the connector component of your
adapter for use with these integration brokers:

* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker, and WebSphere
Business Integration Message Broker, collectively referred to as the WebSphere
Message Brokers (WMQI)

* WebSphere Application Server (WAS)

You use Connector Configurator to:

* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and, with ICS, maps for use with collaborations as well as specify
messaging, logging and tracing, and data handler parameters, as required.

The mode in which you run Connector Configurator, and the configuration file
type you use, may differ according to which integration broker you are running.
For example, if WMQI is your broker, you run Connector Configurator directly,
and not from within System Manager (see [‘Running Configurator in stand-alone]

fmode” on page 19).
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Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator incorporates them into your
configuration file as soon as you create the file. However, you do need to set the
value of each standard property in Connector Configurator.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator will
show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties
and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 20| to set up a new one.

Note: Connector Configurator runs only in a Windows environment. If you are
running the connector in a UNIX environment, use Connector Configurator
in Windows to modify the configuration file and then copy the file to your
UNIX environment.

Starting Connector Configurator

You can start and run Connector Configurator in either of two modes:
* Independently, in stand-alone mode
* From System Manager

Running Configurator in stand-alone mode

You can run Connector Configurator independently and work with connector
configuration files, irrespective of your broker.

To do so:

* From Start>Programs, click IBM WebSphere InterChange Server>IBM
WebSphere Business Integration Tools>Connector Configurator.

* Select File>New>Connector Configuration.

* When you click the pull-down menu next to System Connectivity Integration

Broker, you can select ICS, WebSphere Message Brokers or WAS, depending on
your broker.

You may choose to run Connector Configurator independently to generate the file,
and then connect to System Manager to save it in a System Manager project (see
[“Completing a configuration file” on page 241)

Running Configurator from System Manager

You can run Connector Configurator from System Manager.

To run Connector Configurator:
1. Open the System Manager.
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2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator. The
Connector Configurator window opens and displays a New Connector dialog
box.

4. When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS, WebSphere Message Brokers or WAS, depending on
your broker.

To edit an existing configuration file:

* In the System Manager window, select any of the configuration files listed in the
Connector folder and right-click on it. Connector Configurator opens and
displays the configuration file with the integration broker type and file name at
the top.

* From Connector Configurator, select File>Open. Select the name of the
connector configuration file from a project or from the directory in which it is
stored.

* Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing connector definition as the template.

* To create a new template, see [‘Creating a new template” on page 20

* To use an existing file, simply modify an existing template and save it under the
new name. You can find existing templates in your
\WebSphereAdapters\bin\Data\App directory.

Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template in Connector Configurator:
1. Click File>New>Connector-Specific Property Template.
2. The Connector-Specific Property Template dialog box appears.

* Enter a name for the new template in the Name field below Input a New
Template Name. You will see this name again when you open the dialog box
for creating a new configuration file from a template.

* To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template appears in the Template Preview
display.

3. You can use an existing template whose property definitions are similar to
those required by your connector as a starting point for your template. If you
do not see any template that displays the connector-specific properties used by
your connector, you will need to create one.
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 If you are planning to modify an existing template, select the name of the
template from the list in the Template Name table below Select the Existing
Template to Modify: Find Template.

* This table displays the names of all currently available templates. You can
also search for a template.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:

* General:
Property Type
Updated Method
Description

* Flags
Standard flags

* Custom Flag
Flag

After you have made selections for the general characteristics of the property, click
the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1. Click the Value tab. The display panel for Value replaces the display panel for
General.

2. Select the name of the property in the Edit properties display.
3. In the fields for Max Length and Max Multiple Values, enter your values.

To create a new property value:
1. Select the property in the Edit properties list and right-click on it.
2. From the dialog box, select Add.

3. Enter the name of the new property value and click OK. The value appears in
the Value panel on the right.

The Value panel displays a table with three columns:

The Value column shows the value that you entered in the Property Value dialog
box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value dialog
box.

After a value has been created and appears in the grid, it can be edited from
within the table display.

To make a change in an existing value in the table, select an entire row by clicking
on the row number. Then right-click in the Value field and click Edit Value.
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Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Po11Quantity appears in the template only if JMS is the
transport mechanism and DupTicateEventETimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1. In the Available Properties display, select the property that will be made
dependent.

2. In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

3. In the Condition Operator field, select one of the following:
== (equal to)
!= (not equal to)
> (greater than)
< (less than)
>= (greater than or equal to)
<=(less than or equal to)

4. In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

5. With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

6. Click Finish. Connector Configurator stores the information you have entered
as an XML document, under \data\app in the\bin directory where you have
installed Connector Configurator.

Creating a new configuration file

When you create a new configuration file, you must name it and select an
integration broker.

* In the System Manager window, right-click on the Connectors folder and select
Create New Connector. Connector Configurator opens and displays the New
Connector dialog box.

* In stand-alone mode: from Connector Configurator, select File>New>Connector
Configuration. In the New Connector window, enter the name of the new
connector.

You also need to select an integration broker. The broker you select determines the
properties that will appear in the configuration file. To select a broker:

* In the Integration Broker field, select ICS, WebSphere Message Brokers or WAS
connectivity.

 drop-downte the remaining fields in the New Connector window, as described
later in this chapter.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:
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1. Click File>New>Connector Configuration.
2. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator does not check the spelling of the name
that you enter. You must ensure that the name is correct.

e System Connectivity
Click ICS or WebSphere Message Brokers or WAS.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

3. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector name. You can fill in all
the field values to drop-downte the definition now, or you can save the file and
complete the fields later.

4. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running.
If you save as a file, the Save File Connector dialog box appears. Choose *.cfg
as the file type, verify in the File Name field that the name is spelled correctly
and has the correct case, navigate to the directory where you want to locate the
file, and click Save. The status display in the message panel of Connector
Configurator indicates that the configuration file was successfully created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

5. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator window, as described later in this chapter.

Using an existing file

You may have an existing file available in one or more of the following formats:

* A connector definition file.
This is a text file that lists properties and applicable default values for a specific
connector. Some connectors include such a file in a \repository directory in
their delivery package (the file typically has the extension .txt; for example,
CN_XML.txt for the XML connector).

* An ICS repository file.
Definitions used in a previous ICS implementation of the connector may be
available to you in a repository file that was used in the configuration of that
connector. Such a file typically has the extension .in or .out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.
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Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *.cfg, or *.in file from a directory:
1. In Connector Configurator, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

* Configuration (*.cfg)
* ICS Repository (*.1in, =.out)
Choose this option if a repository file was used to configure the connector in

an ICS environment. A repository file may include multiple connector
definitions, all of which will appear when you open the file.

o All files (*.*)
Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator.

3. Click File>Open>From Project.

Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator window displays the configuration screen, with the current attributes
and values.

The title of the configuration screen displays the integration broker and connector
name as specified in the file. Make sure you have the correct broker. If not, change
the broker value before you configure the connector. To do so:

1. Under the Standard Properties tab, select the value field for the BrokerType
property. In the drop-down menu, select the value ICS, WMQI, or WAS.

2. The Standard Properties tab will display the properties associated with the
selected broker. You can save the file now or complete the remaining
configuration fields, as described in [“Specifying supported business object]
[definitions” on page 27.

3. When you have finished your configuration, click File>Save>To Project or
File>Save>To File.

If you are saving to file, select *.cfg as the extension, select the correct location
for the file and click Save.

If multiple connector configurations are open, click Save All to File to save all
of the configurations to file, or click Save All to Project to save all connector
configurations to a System Manager project.
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Before it saves the file, Connector Configurator checks that values have been
set for all required standard properties. If a required standard property is
missing a value, Connector Configurator displays a message that the validation
failed. You must supply a value for the property in order to save the
configuration file.

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator displays a
configuration screen with tabs for the categories of required configuration values.

Connector Configurator requires values for properties in these categories for
connectors running on all brokers:

 Standard Properties

* Connector-specific Properties
¢ Supported Business Objects
* Trace/Log File values

» Data Handler (applicable for connectors that use JMS messaging with
guaranteed event delivery)

Note: For connectors that use JMS messaging, an additional category may display,
for configuration of data handlers that convert the data to business objects.

For connectors running on ICS, values for these properties are also required:
* Associated Maps

* Resources

* Messaging (where applicable)

Important: Connector Configurator accepts property values in either English or
non-English character sets. However, the names of both standard and
connector-specific properties, and the names of supported business
objects, must use the English character set only.

Standard properties differ from connector-specific properties as follows:

* Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

Chapter 3. Configuring the connector 25



A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* Value fields are configurable.

* The Update Method field is displayed for each property. It indicates whether a
component or agent restart is necessary to activate changed values. You cannot
configure this setting.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.
3. After entering all the values for the standard properties, you can do one of the
following:

* To discard the changes, preserve the original values, and exit Connector
Configurator, click File>Exit (or close the window), and click No when
prompted to save changes.

* To enter values for other categories in Connector Configurator, select the tab
for the category. The values you enter for Standard Properties (or any other
category) are retained when you move to the next category. When you close

the window, you are prompted to either save or discard the values that you
entered in all the categories as a whole.

* To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

Setting application-specific configuration properties
For application-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default
property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.
3. To encrypt a property, select the Encrypt box.

4. Choose to save or discard changes, as described for [“Setting standard connector|

properties.”

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Connector-specific Properties window. To decrypt a value, click to clear
the Encrypt check box, enter the correct value in the Verification dialog box, and
click OK. If the entered value is correct, the value is decrypted and displays.
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The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method

Refer to the descriptions of update methods found in the Standard configuration
properties for connectors appendix, under [’Setting and updating property values” on

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator to specify the
business objects that the connector will use. You must specify both generic business
objects and application-specific business objects, and you must specify associations
for the maps between the business objects.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications. For more information, see the
Connector Development Guide for C++ or the Connector Development Guide for
Java.

If ICS is your broker

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name: To designate that a business object definition is supported
by the connector, with System Manager running:

1. Click an empty field in the Business Object Name list. A drop-down list
displays, showing all the business object definitions that exist in the System
Manager project.

2. Click on a business object to add it.

w

Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator window, click Save to Project.
The revised connector definition, including designated support for the added
business object definition, is saved to an ICL (Integration Component Library)
project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator window, click Delete Row.
The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
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of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support: If a business object has Agent Support, the system will attempt to
use that business object for delivering data to an application via the connector
agent.

Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator window does not validate your
Agent Support selections.

Maximum transaction level: The maximum transaction level for a connector is
the highest transaction level that the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

If a WebSphere Message Broker is your broker
If you are working in stand-alone mode (not connected to System Manager), you
must enter the business object name manually.

If you have System Manager running, you can select the empty box under the
Business Object Name column in the Supported Business Objects tab. A combo
box appears with a list of the business object available from the Integration
Component Library project to which the connector belongs. Select the business
object you want from the list.

The Message Set ID is an optional field for WebSphere Business Integration
Message Broker 5.0, and need not be unique if supplied. However, for WebSphere
MQ Integrator and Integrator Broker 2.1, you must supply a unique ID.

If WAS is your broker

When WebSphere Application Server is selected as your broker type, Connector
Configurator does not require message set IDs. The Supported Business Objects
tab shows a Business Object Name column only for supported business objects.

If you are working in stand-alone mode (not connected to System Manager), you
must enter the business object name manually.

If you have System Manager running, you can select the empty box under the
Business Object Name column in the Supported Business Objects tab. A combo box
appears with a list of the business objects available from the Integration
Component Library project to which the connector belongs. Select the business
object you want from this list.

Associated maps (ICS only)

Each connector supports a list of business object definitions and their associated
maps that are currently active in WebSphere InterChange Server. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
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to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:

* Business Object Name
These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator window.

* Associated Maps
The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When ICS boots, it tries to automatically bind a map
to each supported business object for each connector. If more than one map
takes as its input the same business object, the server attempts to locate and
bind one map that is the superset of the others.
If there is no map that is the superset of the others, the server will not be able to
bind the business object to a single map, and you will need to set the binding
explicitly.
To explicitly bind a map:
1. In the Explicit column, place a check in the check box for the map you want

to bind.

2. Select the map that you intend to associate with the business object.

3. In the File menu of the Connector Configurator window, click Save to
Project.

4. Deploy the project to ICS.
5. Reboot the server for the changes to take effect.

Resources (ICS)

The Resource tab allows you to set a value that determines whether and to what
extent the connector agent will handle multiple processes concurrently, using
connector agent parallelism.

Not all connectors support this feature. If you are running a connector agent that
was designed in Java to be multi-threaded, you are advised not to use this feature,

since it is usually more efficient to use multiple threads than multiple processes.
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Messaging (ICS)

The messaging properties are available only if you have set MQ as the value of the
DeliveryTransport standard property and ICS as the broker type. These properties
affect how your connector will use queues.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator uses the logging and tracing values of that file as default
values. You can change those values in Connector Configurator.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT):
Writes logging or tracing messages to the STDOUT display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

* To File:
Writes logging or tracing messages to a file that you specify. To specify the
file, click the directory button (ellipsis), navigate to the preferred location,
provide a file name, and click Save. Logging or tracing message are written
to the file and location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .1og and .txt are typical file extensions.

Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Not all adapters make use of data handlers.

See the descriptions under ContainerManagedEvents in Appendix A, Standard
Properties, for values to use for these properties. For additional details, see the
Connector Development Guide for C++ or the Connector Development Guide for Java.

Saving your configuration file

When you have finished configuring your connector, save the connector
configuration file. Connector Configurator saves the file in the broker mode that
you selected during configuration. The title bar of Connector Configurator always
displays the broker mode (ICS, WMQI or WAS) that it is currently using.

The file is saved as an XML document. You can save the XML document in three

ways:

¢ From System Manager, as a file with a *.con extension in an Integration
Component Library, or

* In a directory that you specify.
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* In stand-alone mode, as a file with a *.cfg extension in a directory folder. By
default, the file is saved to \WebSphereAdapters\bin\Data\App.

* You can also save it to a WebSphere Application Server project if you have set
one up.

For details about using projects in System Manager, and for further information
about deployment, see the following implementation guides:

* For ICS: Implementation Guide for WebSphere InterChange Server

* For WebSphere Message Brokers: Implementing Adapters with WebSphere Message
Brokers

* For WAS: Implementing Adapters with WebSphere Application Server

Changing a configuration file

You can change the integration broker setting for an existing configuration file.
This enables you to use the file as a template for creating a new configuration file,
which can be used with a different broker.

Note: You will need to change other configuration properties as well as the broker
mode property if you switch integration brokers.

To change your broker selection within an existing configuration file (optional):
* Open the existing configuration file in Connector Configurator.
* Select the Standard Properties tab.
* In the BrokerType field of the Standard Properties tab, select the value that is
appropriate for your broker.
When you change the current value, the available tabs and field selections on

the properties screen will immediately change, to show only those tabs and
fields that pertain to the new broker you have selected.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator in a globalized environment

Connector Configurator is globalized and can handle character conversion between
the configuration file and the integration broker. Connector Configurator uses
native encoding. When it writes to the configuration file, it uses UTF-8 encoding.

Connector Configurator supports non-English characters in:

¢ All value fields

* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the

drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.
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For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"

isRequired="true"

updateMethod="component restart">

<ValidType>String</ValidType>
<ValidValues>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>

<DefaultValue>en US</DefaultValue>
</ValidValues>
</Property>

Creating multiple connector instances

This topic contains an overview and procedure for creating multiple connector
instances.

Overview of creating multiple connector instances

Creating multiple instances of a connector is in many ways the same as creating a
custom connector. You can set your system up to create and run multiple instances
of a connector by following the steps below. You must:

* Create a new directory for the connector instance

* Make sure you have the requisite business object definitions
* Create a new connector definition file

* Create a new start-up script

Steps for creating a new directory

You must create a connector directory for each connector instance. This connector
directory should be named:

ProductDir\connectors\connectorInstance
where connectorInstance uniquely identifies the connector instance.

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file, create
this directory and store the file here:

ProductDir\repository\connectorInstance

Steps for creating business object definitions
If the business object definitions for each connector instance do not already exist
within the project, you must create them.

1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer to
import them. You can copy any of the files for the initial connector. Just rename
them if you make changes to them.

2. Files for the initial connector should reside in the following directory:
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ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Steps for creating a connector definition
You create a configuration file (connector definition) for the connector instance in
Connector Configurator. To do so:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Steps for creatinga start-up script
To create a startup script:

1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

2. Put this startup script in the connector directory you created in
[creating a new directory” on page 32

3. Create a startup script shortcut (Windows only).

4. Copy the initial connector’s shortcut text and change the name of the initial
connector (in the command line) to match the name of the new connector
instance.

You can now run both instances of the connector on your integration server at the
same time.

For more information on creating custom connectors, refer to the Connector
Development Guide for C++ or for Java.

Verifying a sample configuration

To verify a sample configuration, do the following;:

* See|Appendix C, “Tutorial,” on page 87] The tutorial uses samples that are
shipped with the adapter so you can configure and run a sample scenario
quickly.

Setting Queue Uniform Resource Identifiers (URI)

You can use Uniform Resource Identifiers to designate queues and to establish or
modify values for those queues. You do this when specifying values for the
connector specific properties that define queues.

To set queue URIs, do the following:

* Using Connector Configurator, specify a connector-specific queue using the
syntax described below.

Queue URI syntax: The URI for a queue begins with the sequence queue://
followed by:

* The name of the queue manager on which the queue resides
* Another /
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¢ The name of the queue

* Optionally, a list of name-value pairs to set the remaining queue properties.

For example, the following URI connects to queue IN on queue manager
crossworlds.queue.manager and causes all messages to be sent as WebSphere MQ
messages with priority 5.
queue://crossworlds.queue.manager/IN?targetClient=18&persistence=5

able 11{ shows property names for queue URIs.

Table 11. WebSphere Business Integration Message Broker queue URI properties

Property name

expiry

priority

persistence

CCSID

targetClient

encoding

Description Values

Lifetime of the message in milliseconds. 0 = unlimited.

positive integers = timeout (in ms).

Priority of the message. 0-9, where 1 is the highest priority. A value of
-1 means that the property should be
determined by the configuration of the queue.
A value of -2 specifies that the connector can
use its own default value.

Whether the message should be ‘hardened’ to 1 = non-persistent

disk.
2 = persistent

A value of -1 means that the property should be
determined by the configuration of the queue.
A value of -2 specifies that the connector can
use its own default value.

Character set of the destination. Integers - valid values listed in base WebSphere
Business Integration Message Broker
documentation. This value should match that of
the CCSID connector-specific configuration
property. See [“CCSID” on page 83

Whether the receiving application is JMS 0 = JMS (MQRFH2 header)

compliant or not.

1 = MQ (MQMD header only)

How to represent numeric fields. An integer value as described in the base
WebSphere Business Integration Message
Broker documentation.

Note: The connector has no control of the character set (CCSID) or encoding
attributes of data in MQ messages. Because data conversion is applied as the
data is retrieved from or delivered to the message buffer, the connector
relies upon the IBM WebSphere MQ implementation of JMS to convert data
(see the IBM MQSeries Java client library documentation). Accordingly, these
conversions should be bi-directionally equivalent to those performed by the
native MQSeries, or WebSphere MQ, API using option MQGMO_CONVERT. The
connector has no control over differences or failures in the conversion
process. The connector can retrieve message data of any CCSID or encoding
supported by WebSphere MQ without additional modifications. To deliver a
message of a specific CCSID or encoding, the output queue must be a
fully-qualified URI and specify values for CCSID and encoding. The
connector passes this information to WebSphere MQ, which (via the JMS
API) uses the information when encoding data for MQMessage delivery.
Often, lack of support for CCSID and encoding can be resolved by
downloading the most recent version of the IBM MQSeries Java client
library from IBM’s web site. If problems specific to CCSID and encoding

34 Adapter for WebSphere Business Integration Message Broker User Guide



persist, contact WebSphere business integration system Technical Support to
discuss the possibility of using an alternate Java Virtual Machine to run the
connector.

Guaranteeing event delivery

The guaranteed-event-delivery feature enables the connector framework to ensure
that events are never lost and never sent twice between the connector’s event
store, the JMS event store, and the destination’s J]MS queue. To become
JMS-enabled, you must configure the connectorDeliveryTransport standard
property to JMS. Thus configured, the connector uses the JMS transport and all
subsequent communication between the connector and the integration broker
occurs through this transport. The JMS transport ensures that the messages are
eventually delivered to their destination. Its role is to ensure that once a
transactional queue session starts, the messages are cached there until a commit is
issued; if a failure occurs or a rollback is issued, the messages are discarded.

Note: Without use of the guaranteed-event-delivery feature, a small window of
possible failure exists between the time that the connector publishes an
event (when the connector calls the gotApplEvent() method within its
pollForEvents() method) and the time it updates the event store by deleting
the event record (or perhaps updating it with an “event posted” status). If a
failure occurs in this window, the event has been sent but its event record
remains in the event store with an “in progress” status. When the connector
restarts, it finds this event record still in the event store and sends it,
resulting in the event being sent twice.

You can configure the guaranteed-event-delivery feature for a JMS-enabled
connector with, or without, a JMS event store. To configure the connector for
guaranteed event delivery, see instructions in the Connector Development Guide for
Java.

If connector framework cannot deliver the business object to the ICS integration
broker, then the object is placed on a FaultQueue (instead of UnsubscribedQueue
and ErrorQueue) and generates a status indicator and a description of the problem.
FaultQueue messages are written in MQRFH?2 format.
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Chapter 4. Running the connector

« |"Configuring startup files”|

« [“Starting the connector” on page 38|

+ |“Stopping the connector” on page 39|

» [“Overview of error handling” on page 39

* |“Overview of tracing” on page 41

This chapter describes how to configure connector startup files and how to start
and stop the connector.

Overview of running the connector

You are ready to run the connector if you have done the following:
* Installed the connector and related files

* Configured business objects and meta-objects

* Configured a data handler

* Configured the connector

In this chapter

This chapter covers the following tasks.

Table 12. Running the adapter: task roadmap

Task Associated procedure(s) (see...) For more information (see...)

Configuring startup [“Configuring startup files”| Connector Development Guide

files

Starting the |“Starting the connector” on page 3§

connector

Stopping the “Stopping the connector” on page| [‘Overview of mapping datal

connector 39 handlers to input queues” on|
[page 52]

Configuring startup files

Before you start the connector for WebSphere Business Integration Message Broker,
you must configure the startup file.

Steps for configuring startup files for Windows platforms

To complete the configuration of the connector for Windows platforms, you must
modify the start_WBIMB.bat file:

1. Open the start_WBIMB.bat file.

2. Scroll to the section beginning with “Set the directory containing your
WebSphereMQ Java client Tibraries,” and specify the location of your
WebSphere MQ Java client libraries.

Steps for configuring startup files for UNIX platforms
To complete the configuration of the connector for UNIX platforms, you must

modify the start_WBIMB.sh file:

© Copyright IBM Corp. 2000, 2004 37



1. Open the start_WBIMB.sh file.

2. Scroll to the section beginning with “Set the directory containing your
WebSphere MQ Java client Tibraries,” and specify the location of your
WebSphere MQ Java client libraries.

Starting the connector

A connector must be explicitly started using its connector start-up script. The
startup script should reside in the connector’s runtime directory:

ProductDir\connectors\connName

where connName identifies the connector. The name of the startup script depends
on the operating-system platform, as shows.

Table 13. Startup scripts for a connector

Operating system Startup script
UNIX-based systems connector_manager_connName
Windows start_connName .bat

You can invoke the connector startup script in any of the following ways:
* On Windows systems, from the Start menu
Select Programs>IBM WebSphere Business Integration
Adapters>Adapters>Connectors. By default, the program name is “IBM
WebSphere Business Integration Adapters”. However, it can be customized.
Alternatively, you can create a desktop shortcut to your connector.
e From the command line
— On Windows systems:
start_connName connName brokerName [-cconfigFile ]
— On UNIX-based systems:
connector_manager_connName -start

where connName is the name of the connector and brokerName identifies your
integration broker, as follows:

— For WebSphere InterChange Server, specify for brokerName the name of the
ICS instance.

— For WebSphere message brokers (WebSphere MQ Integrator, WebSphere MQ
Integrator Broker, or WebSphere Business Integration Message Broker) or
WebSphere Application Server, specify for brokerName a string that identifies
the broker.

Note: For a WebSphere message broker or WebSphere Application Server on a
Windows system, you must include the -c option followed by the name of
the connector configuration file. For ICS, the -c is optional.

* From Adapter Monitor (WebSphere Business Integration Adapters product only),
which is launched when you start System Manager

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

e From System Monitor (WebSphere InterChange Server product only)

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.
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¢ On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for an
Auto service) or when you start the service through the Windows Services
window (for a Manual service).

For more information on how to start a connector, including the command-line
startup options, refer to one of the following documents:

* For WebSphere InterChange Server, refer to the System Administration Guide.

* For WebSphere message brokers, refer to Implementing Adapters with WebSphere
Message Brokers.

* For WebSphere Application Server, refer to Implementing Adapters with WebSphere
Application Server.

Stopping the connector

The way to stop a connector depends on the way that the connector was started,
as follows:

* If you started the connector from the command line, with its connector startup
script:

— On Windows systems, invoking the startup script creates a separate “console”
window for the connector. In this window, type “Q” and press Enter to stop
the connector.

— On UNIX-based systems, connectors run in the background so they have no
separate window. Instead, run the following command to stop the connector:

connector_manager_connName -stop
where connName is the name of the connector.

* From Adapter Monitor (WebSphere Business Integration Adapters product only),
which is launched when you start System Manager

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

¢ From System Monitor (WebSphere InterChange Server product only)

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector stops when the Windows system shuts down.

Overview of error handling

All error messages generated by the connector are stored in a message file named
MQSIV2Connector.txt. (The name of the file is determined by the LogFileName
standard connector configuration property.) Each error has an error number
followed by the error message:

Message number
Message text

The connector handles specific errors as described in the following sections.

Application timeout
The error message ABON_APPRESPONSETIMEOUT is returned when:

* The connector cannot establish a connection to the JMS service provider during
message retrieval.
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* The connector successfully converts a business object to a message but cannot
deliver it the outgoing queue due to connection loss.

* The connector issues a message but times out waiting for a response for a
business object with conversion property TimeoutFatal equal to True.

* The connector receives a response message with a return code equal to
APP_RESPONSE_TIMEOUT or UNABLE_TO_LOGIN.

Unsubscribed business object

The connector delivers a message to the queue specified by the UnsubscribedQueue

property if:

* The connector retrieves a message that is associated with an unsubscribed
business object or when a NO_SUBSCRIPTION_FOUND code is returned by the
gotApplEvent () method.

* The connector retrieves a message but cannot associate the text in the FORMAT
field with a business object name.

Note: If the UnsubscribedQueue is not defined, unsubscribed messages will be
discarded.

Connector not active

When the gotApplEvent () method returns a CONNECTOR_NOT_ACTIVE code,
the pol1ForEvents() method returns an APP_RESPONSE_TIMEOUT code and the
event remains in the InProgress queue.

Data handler conversion

If the data handler fails to convert a message to a business object, or if a
processing error occurs that is specific to the business object (as opposed to the
JMS provider), the message is delivered to the queue specified by ErrorQueue. If
the ErrorQueue is not defined, messages that cannot be processed due to errors will
be discarded.

If the data handler fails to convert a business object to a message, BON_FAIL is
returned.

JMS properties

If a JMS property cannot be read from or written to a message, the connector logs
an error and the request or event fails. If a you do not specify a ReplyToQueue or it
cannot be accessed, the connector logs an error and the request fails. If a
CorrelationID is invalid or cannot be set, the connector logs an error and the
request fails.

In all cases, the message logged is from the connector message file.

Overloading input formats

When retrieving a message, the connector normally matches the input format to
one specific business object and verb combination. The connector then passes the
business object name and the contents of the message to the data handler. This
allows the data handler to verify that the message contents correspond to the
business object that the user expects.

If, however, the same input format is defined for more than one business object,
the connector will be unable to determine which business object the data
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represents before passing it to the data handler. In such cases, the connector passes
the message contents only to the data handler and then looks up conversion
properties based on the business object that is generated. Accordingly, the data
handler must determine the business object based on the message content alone.

If the verb on the generated business object is not set, the connector searches for
conversion properties defined for this business object with any verb. If only one set
of conversion properties is found, the connector assigns the specified verb. If more
properties are found, the connector fails the message because it is unable to
distinguish among the verbs.

Overview of tracing

Tracing is an optional debugging feature you can turn on to closely follow
connector behavior. Trace messages, by default, are written to STDOUT. See the
connector configuration properties in Chapter 2 for more on configuring trace
messages. For more information on tracing, including how to enable and set it, see
the Connector Development Guide for Java.

What follows is recommended content for connector trace messages.

Level 0 This level is used for trace messages that identify the connector
version.
Level 1 Use this level for trace messages that provide key information on

each business object processed or record each time a polling thread
detects a new message in an input queue.

Level 2 Use this level for trace messages that log each time a business
object is posted to InterChange Server, either from gotAppl1Event ()
or executeCollaboration().

Level 3 Use this level for trace messages that provide information
regarding data-format (for example, XML)-to-business-object and
business-object-to-data-format conversions or provide information
about the delivery of the message to the output queue.

Level 4 Use this level for trace messages that identify when the connector
enters or exits a function.

Level 5 Use this level for trace messages that indicate connector
initialization, represent statements executed in the application,
indicate whenever a message is taken off of or put onto a queue,
or record business object dumps.
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Chapter 5. Cre

ating objects

“Overview of creating objects”]

“Creating business objects”

“Modifying business objects” on page 45|

“Creating meta-objects” on page 47]

This chapter describes what you must do to create and modify business objects
and meta-objects. Both are required for the connector to function properly.

Overview of creating objects

You must create definitions for two kinds of objects:

business objects These represent business entities (an employee or catalog item)
or data transactions (create, update, delete) and also contain the
application-specific instructions to process the data. The connector comes with
sample business objects only and these are for use with the tutorial. You must
build business object definitions for the connector.

meta-objects A configuration meta-object defines the data formats, queues,
mapping, message header information, and response times that govern how the
connector exchanges business objects and messages. The connector comes with a
sample meta-object only. You can modify this sample for use with your adapter,
or you can create your own meta-objects. You must configure a meta-object with
one or more properties or the connector will not function properly.

In this chapter
The tasks described in this chapter are as follows:

Table 14. Creating objects: task roadmap

Task Associated procedure(s) (see...) For more information (see...)
Creating business |“Creating business objects’] Business Object Development
objects Guide

Modifying business |“Modifying business objects” on| Business Object Development
objects page 45 Guide

Creating meta- |“Creating meta-objects” on page 47] |“Overview of creating static|
objects meta-objects” on page 50}

“Overview of creating dynamic|
child meta-objects” on page 52|

Mapping data “Steps for mapping data handlerd [|‘Overview of mapping datal
handlers to input to input queues” on page 52| handlers to input queues” on|

queues page 52|

Creating business objects

This topic contains an overview and a procedure for creating definitions for
business objects.

Overview of creating business objects

After installing the connector, you must create definitions for business objects.
There are no requirements regarding the structure of the business objects other
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than those imposed by the configured data handler and by attributes in the
meta-object. When you decide on the data format for your connector, you must
configure a suitable data handler and generate conforming business objects.

The WBI Message Broker provides native support for XML messages. In fact, the
adapter for WBI Message Broker is configured, by default, for an XML data
handler. This means that the adapter uses the XML data handler for business
object-to-message and message-to-business object conversion.

Note: You can use any available non-XML data handler, or build a custom data
handler, to support message and business object requirements. You then
configure the data handler for use with the connector, and modify the
message flows accordingly. For further information on available and custom
data handlers, see the Data Handler Guide. For further information on
configuring a data handler for use with the adapter and modifying the
message flows, see [Chapter 6, “Configuring a data handler,” on page 57|

To construct business objects for use with the XML data handler, you use the XML
Object Discovery Agent (ODA). The XML ODA generates business object
definitions for an XML document based on either its DTD or schema document.
These business objects can then be used with the adapter. Samples shipped with
the WBI Message Broker adapter provide files that are configured to use the XML
data handler for business object conversion.

Note: The business objects that the connector processes can have any name
allowed by the integration broker. For more on naming conventions for
InterChange Server, see Naming IBM WebSphere InterChange Server
Components.

Steps for creating business objects

Before you begin: You must identify the data format (XML, for example) for the
messages and business objects that the connector will exchange.

To create business objects for the connector perform the following steps:

1. Use an Object Discovery Agent (ODA) (if available) to generate the business
object definitions. For example, to create business objects for a connector
configured to exchange XML messages, you would use the XML ODA. For
further information, see the Data Handler Guide.

2. Use Business Object Designer, as needed, to modify or add to information
generated by the ODA. For further information, see the Business Object
Development Guide.

Note: If an ODA is not available for your data format, you can create definitions
for business objects by using Business Object Designer. For further
information, see the Business Object Development Guide.

After creating business object definitions, you then use Connector Configurator to
add them to the list of those supported by the connector. For further information

on using Connector Configurator, see [Chapter 6, “Configuring a data handler,” on|
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Modifying business objects

You can modify business objects to take advantage of processing capabilities. When
you modify business objects, you use Business Object Designer. For further
information, see the Business Object Development Guide.

This topic contains an overview and procedure for modifying a business object to
enable a synchronous request processing feature.

Overview of filtering response messages with a message
selector

Upon receiving a business object for synchronous request processing, the connector
checks for the presence of a response_selector string in the application-specific
information of the verb. If the response_selector is undefined, the connector
identifies response messages using the correlation ID as described in
fexists and retrieve by content” on page 7.

If response_selector is defined, the connector expects a name-value pair with the
following syntax:

response_selector=JMSCorrelationID LIKE ’selectorstring’

The message selectorstring must uniquely identify a response and its values be
enclosed in single quotes as shown in the example below:

response_selector=JMSCorrelationID LIKE 'Oshkosh'

In the above example, after issuing the request message, the adapter would
monitor the ReplyToQueue for a response message with a correlationID equal to
"Oshkosh.” The adapter would retrieve the first message that matches this message
selector and then dispatch it as the response.

Steps for filtering response messages with a message
selector

To filter a response message with a message selector, do the following:
1. Launch Business Object Designer

2. Open the business object that you want to convert for synchronous message
delivery.

3. In the application-specific information of the verb, specify
response_selector=JMSCorrelationID LIKE ’selectorstring’
where selectorstring uniquely identifies a response. When the application returns
a response with the selectorstring you specified as a CorrelationID, the connector
identifies it as the response to the synchronous request. The connector then
calls the data handler to convert it to a response business object, and returns it
to the requesting collaboration.

Note: You can specify multiple selectorstrings. You can also specify special
characters, reference attributes in (static and dynamic) meta-objects, and
enable swapping of selectorstrings. For illustration, see the examples
below.

Examples: Optionally, the adapter performs run-time substitutions enabling you to
generate unique message selectors for each request. Instead of a message selector,
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you specify a placeholder in the form of an integer surrounded by curly braces, for
example: '{1}'. You then follow with a colon and a list of comma-separated
attributes to use for the substitution. The integer in the placeholder acts as an
index to the attribute to use for the substitution. For example, the following
message selector:

response_selector=JMSCorrelationID LIKE '{1}': MyDynamicMO.CorrelationID

would inform the adapter to replace {1} with the value of the first attribute
following the selector (in this case the attribute named CorrelationId of the
child-object named MyDynamicMO0. If attribute CorrelationID had a value of 123ABC,
the adapter would generate and use a message selector created with the following
criteria:

JMSCorrelation LIKE '123ABC'
to identify the response message.
You can also specify multiple substitutions such as the following:

response_selector=PrimaryId LIKE '{1}' AND AddressId LIKE '{2}"
PrimaryId, Address[4].AddressId

In this example, the adapter would substitute {1} with the value of attribute
Primaryld from the top-level business object and {2} with the value of AddressId
from the 5th position of child container object Address. With this approach, you
can reference any attribute in the business object and meta-object in the response
message selector. For more information on how deep retrieval is performed using
Address[4] .AddressId, see JCDK API manual (getAttribute method)

An error is reported at run-time when any of the following occurs:

 If you specify a non-integer value between the '{}' symbols

* If you specify an index for which no attribute is defined
* If the attribute specified does not exist in the business or meta-object

* If the syntax of the attribute path is incorrect

For example, if you include the literal value "{" or ’}" in the message selector, you
can use '{{’ or "{}" respectively. You can also place these characters in the attribute
value, in which case the first "{" is not needed. Consider the following example
using the escape character: response_selector=JMSCorrelation LIKE '{1}' and
CompanyName="A{{P"': MyDynamicM0.CorrelationID

The connector would resolve this message selector as follows:

JMSCorrelationID LIKE '123ABC' and CompanyName='A{P'
When the connector encounters special characters such as '{’, '}, " or ’;’ in
attribute values, they are inserted directly into the query string. This allows you to
include special characters in a query string that also serve as application-specific
information delimiters.

The next example illustrates how a literal string substitution is extracted from the
attribute value:
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response_selector=JMSCorrelation LIKE '{1}' and CompanyName='A{{P':
MyDynamicMO.CorrelationID

If MyDynamicMO.CorrelationID contained the value {A:B}C;D, the connector would
resolve the message selector as follows: JMSCorrelationID LIKE '{A:B}C;D' and
CompanyName="A{P'

For more information on the response selector code, see JMS 1.0.1 specifications.

Creating meta-objects

This topic contains an overview and procedures for creating meta-objects.

The connector uses meta-object entries to determine which business object to
associate with a message. The type of business object and verb used in processing
an event message is based on the FORMAT field contained in the WebSphere MQ
message header. You construct a meta-object attribute to store the business object
name and verb to associate with the WebSphere MQ message header FORMAT field
text. Meta-object attributes also contain message processing guidelines.

When a message is retrieved from the input queue, the connector looks up the
business object name associated with the FORMAT text field. The message, along
with the business object name, is then passed to the data handler. If a business
object is successfully populated with message content, the connector checks to see
if it is subscribed, and then delivers it to the integration broker using the
gotApplEvents() method.

The connector for WebSphere Business Integration Message Broker can recognize
and read two kinds of meta-objects:

* a static connector meta-object

* a dynamic child meta-object

The attribute values of the dynamic child meta-object duplicate and override those
of the static meta-object.

When deciding upon which meta-object will work best for your implementation,
consider the following:

* Static meta-object

— Useful if all meta-data for different messages is fixed and can be specified at
configuration time.

— Limits you to specifying values by business-object type. For example, all
Customer-type objects must be sent to the same destination.

* Dynamic meta-object
— Gives business processes access to information in message headers

— Allows business processes to change processing of messages at run-time,
regardless of business type. For example, a dynamic meta-object would allow
you to specify a different destination for every Customer-type object sent to
the adapter.

— Requires changes to the structure of supported business objects—such
changes may require changes to maps and business processes.

— Requires changes to custom data handlers.
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Meta-object properties
provides a complete list of properties supported in meta-objects. Refer to

these properties when implementing meta-objects. Your meta object should have
one or more of the properties shown in [Table 1

Not all properties are available in both static and dynamic meta-objects. Nor are all
properties are readable from or writable to the message header. See the appropriate
sections on event and request processing in [Chapter 1, “Overview,” on page 1to
determine how a specific property is interpreted and used by the connector.

Table 15. WBI Message Broker adapter meta-object properties

Definable in

Definable in dynamic
Property name static meta-object meta-object Description
DataHandlerConfigM0  Yes Yes Meta-object passed to data handler to provide

configuration information. If specified in the static
meta-object, this will override the value specified in
the DataHandlerConfigMO connector property. Use this
meta-object property when different data handlers
are required for processing different business object
types. Use the dynamic child meta-object for request
processing when the data format may be dependent
on the actual business data. The specified business
object must be supported by the connector agent. See
the description in|Appendix B, “Connector-specific|
roperties for the WBI Message Broker adapter,” on|
page 81‘|
DataHandlerMimeType  Yes Yes Allows you to request a data handler based on a
particular MIME type. If specified in the meta-object,
this will override the value specified in the
DataHandlerMimeType connector property. Use this
meta-object property when different data handlers
are required for processing different business object
types. Use the dynamic child meta-object for request
processing when the data format might be dependent
on the actual business data. The business object
specified in DataHandlerConfigM0 should have an
attribute that corresponds to the value of this
roperty. See the description in |prendix B,l
‘Connector-specific properties for the WBI Message]
Broker adapter,” on page 81]
DataHandlerClassName Yes Yes See the description in [Appendix B
‘Connector-specific properties for the WBI Message]
Broker adapter,” on page 81
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Table 15. WBI Message Broker adapter meta-object properties (continued)

Property name

InputFormat

QutputFormat

InputQueue

QutputQueue

ResponseTimeout

TimeoutFatal

Definable in

Definable in
dynamic

static meta-object meta-object

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Yes

Description

Format or type of inbound (event) message to
associate with the given business object. This value
helps identify the message content and is specified by
the application that generated the message. When a
message is retrieved and is in this format, it is
converted to the given business object, if possible. If
this format is not specified for a business object, the
connector does not handle subscription deliveries for
the given business object. Do not set this property
using default meta-object conversion properties; its
value is used to match incoming messages to
business objects. The field that the connector
considers as defining the format in the message can
be user-defined via the connector-specific property
MessageFormatProperty.

Format to be populated in outbound messages. If the
OutputFormat is not specified, the input format is
used, if available.

The input queue that the connector polls to detect
new messages. This property is used to match
incoming messages to business objects only. Do not
set this property using default conversion properties;
its value is used to match incoming messages to
business objects.

Note: The InputQueue property in the
connector-specific properties defines which queues
the adapter polls. This is the only property that the
adapter uses to determine which queues to poll. In
the static MO, the InputQueue property and the
InputFormat property can serve as criteria for the
adapter to map a given message to a specific
business object. To implement this feature, you would
use connector-specific properties to configure
multiple input destinations and optionally map
different data handlers to each one based on the
input formats of incoming messages. For information,
see |“Overview of mapping data handlers to inpuf
lqueues” on page 52|

Queue to which messages derived from the given
business object are delivered.

Indicates the length of time in milliseconds to wait
before timing out when waiting for a response in
synchronous request processing. The connector
returns SUCCESS immediately without waiting for a
response if this is left undefined or with a value less
than zero.

Used in synchronous request processing to trigger the
connector to return an error message if a response is
not received. If this property is True, the connector
returns APPRESPONSETIMEOUT to the broker when
a response is not received within the time specified
by ResponseTimeout. If this property is undefined or
set to False, then on a response timeout the
connector fails the request but does not terminate.
Default = False.
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Table 15. WBI Message Broker adapter meta-object properties (continued)

Property name

Definable in
Definable in dynamic
static meta-object meta-object Description

Below are fields mapping specifically to the JMS message header. For specific explanations, interpretation of values, and more, see
the JMS API specification. JMS providers may interpret some fields differently so also check your JMS provider documentation

for any deviations.
ReplyToDestination

Type

MessagelD
CorrelationID

Delivery Mode

Priority
Destination

Expiration
Redelivered

Timestamp
UserID

AppID
DeliveryCount
GrouplID
GroupSeq

JMSProperties

Yes Destination to which a response message for a
request is to be sent.
Yes Type of message. Generally user-definable,
depending on JMS provider.
Yes Unique ID for message (JMS provider specific).
Yes Yes Used in response messages to indicate the ID of the
request message that initiated this response.
Yes Yes Specifies whether the message is persisted or not in

the MOM system. Acceptable values:
1=non-persistent

2=persistent

Other values, depending on the JMS provider, may
be available.

Yes Numeric priority of message. Acceptable values: 0
through 9 inclusive (low to high priority).

Yes Current or last (if removed) location of message in
MOM system.

Yes Time-to-live of message.

Yes Indicates that the JMS provider most likely attempted

to deliver the message to the client earlier but receipt
was not acknowledged.

Yes Time message was handed off to JMS provider.

Yes Identity of the user sending the message.

Yes Identity of the application sending the message.

Yes Number of delivery attempts.

Yes Identity of the message group.

Yes Sequence of this message in the message group
specified in GrouplD.

Yes See |“]JMS properties” on page 54

Overview of creating static meta-objects

The WebSphere Business Integration Message Broker configuration meta-object
consists of a list of conversion properties defined for different business objects. To
view a sample static meta-object, launch Business Object Designer and open the
following sample that is shipped with the adapter:
connectors\WBIMB\samples\LegacyItem\Sample_WBIMB_MO_Config.xsd

The connector supports at most one static meta-object at any given time. You
implement a static meta-object by specifying its name for connector property
ConfigurationMetaObject

The structure of the static meta-object is such that each attribute represents a single
business object and verb combination and all the meta-data associated with
processing that object. The name of each attribute should be the name of the
business object type and verb separated by an underscore, such as
Customer_Create. The attribute application-specific information should consist of
one or more semicolon-delimited name-value pairs representing the meta-data
properties you want to specify for this unique object-verb combination.

50 Adapter for WebSphere Business Integration Message Broker User Guide



Table 16. Static meta-object structure

Attribute name Application-specific text
<business object type> <verb> property=value;property=value;...
<business object type> <verb> property=value;property=value;...

For example, consider the following meta-object:

Table 17. Sample static meta-object structure

Attribute name Application-specific information

Customer_Create QutputFormat=CUST;OutputDestination=QueueA
Customer_Update QutputFormat=CUST;OutputDestination=QueueB
Order_Create QutputFormat=0RDER;QutputDestination=QueueC

The meta-object in this sample informs the connector that when it receives a
request business object of type Customer with verb Create, to convert it to a
message with format CUST and then to place it in destination QueueA. If the
customer object instead had verb Update, the message would be placed in QueueB.
If the object type was Order and had verb Create, the connector would convert and
deliver it with format ORDER to QueueC. Any other business object passed to the
connector would be treated as unsubscribed.

Optionally, you may name one attribute Default and assign to it one or more
properties in the ASI. For all attributes contained in the meta-object, the properties
of the default attribute are combined with those of the specific object-verb
attributes. This is useful when you have one or more properties to apply
universally (regardless of object-verb combination). In the following example, the
connector would consider object-verb combinations of Customer_Create and
Order_Create as having OutputDestination=QueueA in addition to their individual
meta-data properties:

Table 18. Sample static meta-object structure

Attribute name Application-specific information
Default QutputDestination=QueueA
Customer_Update QutputFormat=CUST

Order_Create OutputFormat=0RDER

[Table 15 on page 48| describes the properties that you can specify as
application-specific information in the static meta-object.

Note: If a static meta object is not specified, the connector is unable to map a
given message format to a specific business object type during polling.
When this is the case, the connector passes the message text to the
configured data handler without specifying a business object. If the data
handler cannot create a business object based on the text alone, the
connector reports an error indicating that this message format is
unrecognized.

Steps for creating static meta-objects
To implement a static meta-object, do the following:

1. Launch Business Object Designer. For further information, see the Business
Object Development Guide.
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2. Open the sample meta-object
connectors\WBIMB\samples\LegacyItem\Sample WBIMB MO Config.xsd.

3. Edit the attributes and ASI to reflect your requirements, referring to|Table 15 o
and then save the meta-object file.

4. Specify the name of this meta-object file as the value of the connector property
ConfigurationMetaObject.

Overview of mapping data handlers to input queues

You can use the InputQueue property in the application-specific information of the
static meta-object to associate a data handler with an input queue. This feature is
useful when dealing with multiple trading partners who have different formats
and conversion requirements.

Steps for mapping data handlers to input queues
To map a data handler to an InputQueue, do the following:

1. Use connector-specific properties (see [“InputQueue” on page 84) to configure
one or more input queues.

2. Open the static meta-object in Business Object Designer.

3. For each input queue in the static meta-object, specify the queue manager and
input queue name as well as data handler class name and mime type in the
application-specific information.

For example, the following attribute in a static meta-object associates a data
handler with an InputQueue named CompReceipts:

[Attribute]

Name = Cust_Create

Type = String

Cardinality =1

MaxLength = 1

IsKey = false

IsForeignKey = false

IsRequired = false

AppSpecificInfo = InputQueue=//queue.manager/CompReceipts;DataHandlerClassName=
com.crossworlds.DataHandTers.WBIMB.disposition notification;DataHandlerMimeType=
message/

disposition_notification

IsRequiredServerBound = false

[End]

Overview of creating dynamic child meta-objects

If it is difficult or unfeasible to specify the necessary metadata through a static
meta-object, the connector can optionally accept meta-data delivered at run-time
for each business object instance.

Dynamic meta-objects allow you to change the meta-data used by the connector to
process a business object on a per-request basis during request processing, and to
retrieve information about an event message during event processing.

The connector recognizes and reads conversion properties from a dynamic
meta-object that is added as a child to the top-level business object passed to the
connector. The attribute values of the dynamic child meta-object duplicate the
conversion properties that you can specify via the static meta-object that is used to
configure the connector.
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Since dynamic child meta object properties override those found in static
meta-objects, if you specify a dynamic child meta-object, you need not include a
connector property that specifies the static meta-object. Accordingly, you can use a
dynamic child meta-object independently of the static meta-object and vice-versa.

[Table 15 on page 48| describes the properties that you can specify as
application-specific information in the dynamic meta-object.

The following attributes, which reflect J]MS and WebSphere MQ header properties,
are recognized in the dynamic meta-object.

Table 19. Dynamic meta-object header attributes

Header attribute name Mode Corresponding JMS header
CorrelationID Read /Write JMSCorrelationID
RepTyToQueue Read /Write JMSReplyTo
DeliveryMode Read/Write JMSDel1iveryMode
Priority Read /Write JMSPriority
Destination Read JMSDestination
Expiration Read JMSExpiration
MessagelD Read JMSMessagelD
Redelivered Read JMSRedelivered
TimeStamp Read JMSTimeStamp

Type Read JMSType

UserID Read JMSXUserID

AppID Read JMSXAppID
DeliveryCount Read JMSXDeliveryCount
GroupID Read JMSXGroupID
GroupSeq Read JMSXGroupSeq
JMSProperties Read/Write

Read-only attributes are read from a message header during event notification and
written to the dynamic meta-object. These properties also populate the dynamic
MO when a response message is issued during request processing. Read/write
attributes are set on message headers created during request processing. During
event notification, read/write attributes are read from message headers to populate
the dynamic meta-object.

The structure of the dynamic meta-object is such that each attribute represents a
single metadata property and value: meta-object property name =meta-object
property value

Note: All standard IBM WebSphere data handlers are designed to ignore this
dynamic meta-object attribute by recognizing the cw_mo_ tag. You must do
the same when developing custom data handlers for use with the adapter.

Population of the dynamic child meta-object during polling

In order to provide collaborations with more information regarding messages
retrieved during polling, the connector populates specific attributes of the dynamic
meta-object, if already defined for the business object created.

Chapter 5. Creating objects 53



Table [Table 20| shows how a dynamic child meta-object might be structured for

polling.

Table 20. Dynamic child meta-object structure for polling
Property name Sample value
InputFormat CUST_IN

InputQueue MYInputQueue
OutputFormat CxIgnore

OutputQueue CxIgnore
ResponseTimeout CxIgnore

TimeoutFatal CxIgnore

As shown in you can define additional attributes, Input_Format and
InputQueue, in a dynamic child meta-object. The Input_Format is populated with
the format of the message retrieved, while the InputQueue attribute contains the
name of the queue from which a given message has been retrieved. If these
properties are not defined in the child meta-object, they will not be populated.

Example scenario:

* The connector retrieves a message with the format CUST_IN from the queue
MyInputQueue.

* The connector converts this message to a Customer business object and checks
the application-specific text to determine if a meta-object is defined.

* If so, the connector creates an instance of this meta-object and populates the
InputQueue and InputFormat attributes accordingly, then publishes the business
object to available collaborations.

JMS headers and dynamic child meta-object attributes

You can add attributes to a dynamic meta-object to gain more information about,
and more control over, the message transport. This section describes these
attributes and how they affect event notification and request processing.

JMS properties: Unlike other attributes in the dynamic meta-object,
JMSProperties must define a single-cardinality child object. Every attribute in this
child object must define a single property to be read/written in the variable
portion of the J]MS message header as follows:

1. The name of the attribute has no semantic value.

2. The type of the attribute should always be String regardless of the JMS
property type.

3. The application-specific information of the attribute must contain two
name-value pairs defining the name and format of the JMS message property to
which the attribute maps. The name is user-definable. The value type must be
one of the following;:

* Boolean
 String
e Int

* Float

* Double
* Long

* Short

* Byte
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The table below shows application-specific information properties that you must
define for attributes in the JMSProperties object.

Table 21. Application-specific information for JMS property attributes

Attribute |Possible values ASI Comments

Name Any valid JMS name=<JMS property Some vendors reserve
property name name>;type=<JMS property type> |certain properties to
(valid = provide extended
compatible with functionality. In
type defined in general, users should
ASI) not define custom

properties that begin
with JMS unless they
are seeking access to
these vendor-specific
features.

Type String type=<see comments> This is the type of the
JMS property. The
JMS API provides a
number of methods
for setting values in
the JMS Message:
setIntProperty,
setLongProperty,
setStringProperty,
etc. The type of the
JMS property
specified here dictates
which of these
methods is used for
setting the property
value in the message.

In the example below, a JMSProperties child object is defined for the Customer
object to allow access to the user-defined fields of the message header:

Customer (ASI = cw _mo_conn=MetaData)
-- Id
-- FirstName
-- LastName
-- ContactInfo
-- MetaData
-- OutputFormat = CUST
-- QutputDestination = QueueA
-- JMSProperties
‘—— RoutingCode = 123 (ASI= name=RoutingCode;type=Int)
-- Dept = FD (ASI= name=RoutingDept;type=String)

To illustrate another example, shows attribute JMSProperties in the
dynamic meta-object and definitions for four properties in the J]MS message
header: ID, GID, RESPONSE and RESPONSE_PERSIST. The application-specific
information of the attributes defines the name and type of each. For example,
attribute ID maps to JMS property ID of type String).
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Figure 4. JMS properties attribute in a dynamic meta-object

Steps for creating a dynamic meta-object
To implement a dynamic meta-object, do the following:

1. Launch Business Object Designer. For further information, see the Business
Object Development Guide.

2. Open the top-level business object whose processing you want to the dynamic
meta-object to influence.

3. Add the dynamic meta-object as a child to your top-level object and include the
name-value pair cw_mo_conn=<M0 attribute> in your top-level object ASI where
<MO attribute> is the name of the attribute in your top-level object
representing the dynamic meta-object. For example:

Customer (ASI = cw_mo_conn=MetaData)
-- Id
-- FirstName
-- LastName
-- ContactInfo
-- MetaData
-- OutputFormat = CUST
-- QutputDestination = QueueA

Upon receipt of a request populated as shown above, the connector would
convert the Customer object to a message with format CUST and then put the
message in queue QueueA.

4. Save the top-level business object.

Note: Business objects can use the same or different dynamic meta-object or none
at all.
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Chapter 6. Conflgurlng a data handler

“Overview of configuring the data handler”|

* |“Specifying the data handler”

* [“Modifying a message flow” on page 58|

This chapter describes how to configure a data handler.

Overview of configuring the data handler

The data handler is a pivotal component in the connector. The connector calls the
data handler to transform business objects into messages and to transform
messages into business objects.

The information in the connector-specific data handler properties plays a crucial
role in these transformations. You configure this information after you install the
product files, but before startup.

Note: You can also map configured data handlers to input queues. For further
information and a procedure, see [‘Overview of mapping data handlers to)
[input queues” on page 52

In this chapter
This tasks described in this chapter are as follows:

Table 22. Configuring the data handler: task roadmap

Task Associated procedure(s) (see...) For more information (see...)
Specifying a data |“Specifying the data handler”|

handler

Modifying a message |“Modifying a message flow” on| Your message broker

flow page 5§ documentation

Specifying the data handler

This topic contains an overview and procedure for specifying the data handler.

Overview of specifying the data handler

You configure a data handler by specifying values for the following
connector-specific configuration properties:

+ [DataHandlerClassNamg
+ |DataHandlerConfigMO)|
+ |DataHandlerMimeType|

For further information on these properties, see XREF

Steps for specifying the data handler

Before you begin: If you are using an XML data handler, you can simply use the
default values for the data handler connector configuration properties. All three of
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these properties—DataHandlerClassName} [DataHandlerConfigMO} and
[DataHandlerMimeType[—are, by default, configured for use with an XML data
handler.

To configure a data handler, do the following:
1. Using Connector Configurator, click the Connector-Specific Properties tab.

2. Specify a property for DataHandlerClassName that corresponds to the data
handler you wish to configure.

3. Specify a property for DataHandlerConfigMO that corresponds to the data
handler you wish to configure.

4. Specify a property for DataHandlerMimeType that corresponds to the data
handler you wish to configure.

5. Apply the properties in Connector Configurator.

Note: Specifying values for these properties in a static or dynamic meta-object
takes precedence over values specified in these connector-specific properties.
For further information, see|“Meta-object properties” on page 48]

Modifying a message flow

This topic contains an overview and procedure for modifying a message flow.

Overview of modifying a message flow

When a WebSphere Business Integration adapter uses a message broker, the
adapter uses WebSphere MQ message flows to process and route data. A single
message flow, defined for each queue, processes all messages placed on that queue.
Using the Message Brokers Toolkit, you can configure a message flow to specify
different processing steps for each type of message it is expected to handle.

You must modify the message flow so that each incoming message is converted to
the format that corresponds to the configured data handler. This conversion must
occur before the message is issued to the input queue of the connector. The
procedure below shows how to modify a message flow for an XML configuration.
To modify a message flow for other data formats, substitute the formats mime type
for XML in the third bullet of step 2.

Steps for modifying a message flow for an XML configuration
Before you begin: Configure the XML data handler.

To modify a message flow for XML, do the following:
1. Launch Message Brokers Toolkit.
2. Add a compute node to the end of a message flow.
3. Enter fields in the ESQL text region as follows:

Set QutputRoot = InputRoot;

This copies the message for output.
Set OutputRoot.MQHRF2.Format = 'SO-CR';

This assures that the connector will check this format and convert the message

appropriately.
SET OutputRoot.Properties.MessageFormat = 'XML';
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This indicates to WebSphere Business Integration Message Broker that the
message should be converted to XML upon delivery.

4. Click Apply to enable the compute node.

shows a sample view of a compute node configured to translate an
incoming message to a format that the connector can understand. Once this
compute node is enabled, an XML document representing the original message is
issued to the connector input queue.

P:i Set message format to XML E2

Set message format to XMLI Advanced] Descrip'{iunl

i e g | [ GeE |

Inputs Qutput Messages

& Cupymessaneheaders ohly 5 Capyentire meEssaie

Mappings ESGL

Get OutputRoot = InputRoot;

det OutputRoot.HMORFHZ.Format = 'S0_CR':

Get OutputRoot. Froperties.MessageFormat = 'XHL';

Drag elements from input to output, or specify SGL, to compose message!
The document OrderExample: SimpleCrder to XhL is not checked out.

[ |

 Cancel i Al | Help |

Figure 5. Setting the message format to XML

Note: If you have defined a custom format in the WebSphere Business Integration
Message Broker Repository Manager, you can convert the legacy format to
XML by simply setting the message format to XML. This format is different
from the MQHRF2. The OutputRoot.Properties.MessageFormat relates to the
MRM, while OutputRoot.MQHRF2.Format is used to specify a message format
for an application that is receiving messages.
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Chapter 7. Troubleshootmg

* |"Troubleshooting start-up problems”|

+ [“Troubleshooting event processing”]

* |“Getting support” on page 62|

This chapter describes problems that you may encounter when starting up or
running the connector. It also describes how to get support from IBM.

Troubleshooting start-up problems

Problem

The connector shuts down unexpectedly during
initialization and the following message is reported:
Exception in thread "main"
java.lang.NoClassDefFoundError:
Jjavax/jms/JIMSException...

The connector shuts down unexpectedly during
initialization and the following message is reported:
Exception in thread "main"
java.lang.NoClassDefFoundError:
com/1ibm/mq/jms/MQConnectionFactory...

The connector shuts down unexpectedly during
initialization and the following message is reported:
Exception in thread "main"
java.lang.NoClassDefFoundError:
javax/naming/Referenceable...

The connector shuts down unexpectedly during

initialization and the following exception is reported:

java.lang.UnsatisfiedLinkError: no mqjbnd01 in
shared Tibrary path

The connector reports MQIMS2005: failed to create
MQQueueManager for ':'

Potential Solution / Explanation

Connector cannot find file jms.jar from the WebSphere
MQ Java client libraries. Ensure that variable
MQSERIES_JAVA_LIB in start_connector.bat points to the
WebSphere MQ Java client libraries folder.

Connector cannot find file com.ibm.mgjms.jar from the
WebSphere MQ Java client libraries. Ensure that variable
MQSERIES_JAVA_LIB in start_connector.bat points to the
WebSphere MQ Java client libraries folder.

Connector cannot find file jndi.jar from the WebSphere
MQ Java client libraries. Ensure that variable
MQSERIES_JAVA_LIB in start_connector.bat points to the
WebSphere MQ Java client libraries folder.

Connector cannot find a required run-time library
(mgjbnd01.d11 [Windows] or 1ibmgjbnd01.so [UNIX])
from the IBM MQSeries Java client libraries. Ensure that
your path includes the WebSphere MQ Java client
libraries folder.

Explicitly set values for the following properties:
HostName, Channel, and Port.

Troubleshooting event processing

Problem

The connector delivers all messages with an
MQRFH2 header.

The connector truncates all message formats to
8-characters upon delivery regardless of how the
format has been defined in the connector
meta-object.

Potential solution / explanation

To deliver messages with only the MQMD WebSphere MQ
header, append ?targetClient=1 to the name of output queue
URI. For example, if you output messages to queue queue:
//my.queue.manager/0UT, change the URI to queue:
//my.queue.manager/0UT?targetClient=1. See
|“Installing the connector,” on page 11| for more information.
This is a limitation of the WebSphere MQ MQMD message
header and not the connector.
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Problem

During pollForEvents, the connector shuts down
after the following JMS exception is reported:
MQIMS1000: Failed to create JMS message

During pol1ForEvents, the connector shuts down
after the following JMS exception is reported:
MQJMS1052: Unrecognised [sic] JMS Message class

Potential solution / explanation

This error appears to relate to the MQ Java API and not the
connector itself. It often occurs when running the connector on
the same machine as the WebSphere Business Integration
Message Broker product itself. To remedy the problem, you
need to perform the following:

1. Unzip the file Product_Dir\Dependencies\JRE_122_4.zip to
folder Product_Dir\connectors\WBIMB\Dependencies\
jre_122_Rel4.

2. Open Product_Dir\connectors\WBIMB\start_MQSIV2.bat
and un-comment the following two lines:oset
PATH=%CONNDIR%\Dependencies\jre_122_Rel4\bin...oset
JAVA=%CONNDIR%\Dependencies\jre_122_Rel4\1ib\rt.jar

3. Restart the connector.

This error can result from modifications made by WebSphere

Business Integration Message Broker to a message originating

from a JMS-compliant application. To correct this, remove

remaining JMS information from problematic messages by
adding the following SQL statement to a WebSphere Business

Integration Message Broker compute node: SET

QutputRoot.MQRFH2.jms = null;

Getting support

Before you begin: Important information about this product may be available in
Technical Support Technotes and Flashes issued after this document was published.
These can be found on the WebSphere Business Integration Support Web site.

Perform the following steps to access the WebSphere Business Integration Support

Web site:

1. Go to http://www.ibm.com/software/integration/websphere/support/

2. Select the component area of interest and browse or search the Technotes and

Flashes sections.
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of WebSphere Business Integration adapters. The information covers
connectors running on the following integration brokers:

* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker, and WebSphere
Business Integration Message Broker, collectively referred to as the WebSphere
Message Brokers (WMQI).

* WebSphere Application Server (WAS)

Not every connector makes use of all these standard properties. When you select
an integration broker from Connector Configurator, you will see a list of the
standard properties that you need to configure for your adapter running with that
broker.

For information about properties specific to the connector, see the relevant adapter
user guide.

Note: In this document, backslashes (\) are used as the convention for directory
paths. For UNIX installations, substitute slashes (/) for backslashes and
follow the conventions for each operating system.

New and deleted properties

These standard properties have been added in this release.

New properties
* XMLNameSpaceFormat

Deleted properties
* RestartCount

Configuring standard connector properties

Adapter connectors have two types of configuration properties:
+ Standard configuration properties
* Connector-specific configuration properties

This section describes the standard configuration properties. For information on
configuration properties specific to a connector, see its adapter user guide.

Using Connector Configurator

You configure connector properties from Connector Configurator, which you access
from System Manager. For more information on using Connector Configurator,
refer to the Connector Configurator appendix.

Note: Connector Configurator and System Manager run only on the Windows

system. If you are running the connector on a UNIX system, you must have
a Windows machine with these tools installed. To set connector properties
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for a connector that runs on UNIX, you must start up System Manager on
the Windows machine, connect to the UNIX integration broker, and bring up
Connector Configurator for the connector.

Setting and updating property values
The default length of a property field is 255 characters.

The connector uses the following order to determine a property’s value (where the
highest number overrides other values):

1. Default

2. Repository (only if WebSphere InterChange Server is the integration broker)
3. Local configuration file

4. Command line

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s Update
Method determines how the change takes effect. There are four different update
methods for standard connector properties:
* Dynamic
The change takes effect immediately after it is saved in System Manager. If the
connector is working in stand-alone mode (independently of System Manager),
for example with one of the WebSphere message brokers, you can only change
properties through the configuration file. In this case, a dynamic update is not
possible.

* Agent restart (ICS only)
The change takes effect only after you stop and restart the application-specific
component.

* Component restart
The change takes effect only after the connector is stopped and then restarted in
System Manager. You do not need to stop and restart the application-specific
component or the integration broker.

* Server restart
The change takes effect only after you stop and restart the application-specific
component and the integration broker.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator window, or see the Update Method column
in [Table 23 on page 65| below.

Summary of standard properties

[Table 23 on page 65| provides a quick reference to the standard connector
configuration properties. Not all the connectors make use of all these properties,
and property settings may differ from integration broker to integration broker, as
standard property dependencies are based on RepositoryDirectory.

You must set the values of some of these properties before running the connector.
See the following section for an explanation of each property.

Note: In the "Notes"column in [Table 23 on page 65| the phrase "Repository
directory is REMOTE" indicates that the broker is the InterChange Server.
When the broker is WMQI or WAS, the repository directory is set to LOCAL
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Table 23. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
|AdminInQueud| Valid JMS queue name CONNECTORNAME /ADMININQUEUE | Component | Delivery
restart Transport is
JMS
[AdminOutQueue] Valid JMS queue name | CONNECTORNAME/ADMINOUTQUEUE | Component | Delivery
restart Transport is
JMS
|AgentConnections| 1-4 1 Component | Delivery
restart Transport is
MQ or IDL:
Repository
directory
is
<REMOTE>
(broker is
1CS)
|AgentTraceLevell 0-5 0 Dynamic
|ApplicationName| Application name Value specified for the Component
connector application name restart
|BrokerType ICS, WMQI, WAS Component
restart
|CharacterEncoding]| ascii7, asciis8, SJIS, ascii7 Component
Cp949, GBK, Big5h, restart
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
Note: This is a subset
of supported
values.
|ConcurrentEventTriggered Flows| 1 to 32,767 1 Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
|ContainerManagedEvents| No value or JMS No value Component | Delivery
restart Transport is
JMS
[ControllerStoreAndForwardMode| | true or false true Dynamic Repository
directory
is
<REMOTE>
(broker is
1CS)
[ControllerTraceLevel| 0-5 0 Dynamic Repository
directory
is
<REMOTE>
(broker is
1CS)
[DeliveryQueus CONNECTORNAME /DELIVERYQUEUE Component | JMS transport
restart only
|DeliveryTransport] MQ, IDL, or JMS JMS Component | If
restart Repository
directory
is local, then
value is
JMS only
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Table 23. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|IDuplicateEventElimination| true or false false Component |JMS transport
restart only: Container
Managed Events
must be
<NONE>
CONNECTORNAME / FAULTQUEUE Component | JMS
restart transport
only
hms.FactoryClassNameI CxCommon.Messaging.jms | CxCommon.Messaging. Component |JMS transport
.IBMMQSeriesFactory or | jms.IBMMQSeriesFactory restart only
CxCommon.Messaging
.jms.SonicMQFactory
or any Java class name
[ims.MessageBrokerName| If FactoryClassName is crossworlds.queue.manager Component |JMS transport
IBM, use restart only
crossworlds.queue.
manager.
If FactoryClassName
is Sonic, use
localhost:2506.
|jms.NumConcurrentRequestsl Positive integer 10 Component |JMS transport
restart only
Any valid password Component |JMS transport
restart only
Any valid name Component |JMS transport
restart only
Heap size in megabytes 128m Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
lvmMaxNativeStackSize| Size of stack in kilobytes | 128k Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
Heap size in megabytes Im Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
|ListenerConcurrency| 1- 100 1 Component | Delivery
restart Transport must
be MQ
Locale en_US, ja_JP, ko KR, en_US Component
zh_CN, zh_TW, fr_FR, restart

de_DE,

it_IT, es_ES, pt_BR
Note: This is a
subset of the
supported

locales.
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Table 23. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|ILog AtInterchangeEnd| true or false false Component | Repository
restart Directory must
be <REMOTE>
(broker is
1Cs)
IMaxEventCapacity| 1-2147483647 2147483647 Dynamic Repository
Directory must
be <REMOTE>
(broker is
1Cs)
[MessageFileName| Path or filename CONNECTORNAMEConnector.txt Component
restart
[MonitorQueue] Any valid queue name CONNECTORNAME /MONITORQUEUE Component | JMS transport
restart only:
DuplicateEvent
Elimination
must be true
[OADAutoRestartAgent| true or false false Dynamic Repository
Directory must
be <REMOTE>
(broker is
1Cs)
|OADMaxNumRetry| A positive number 1000 Dynamic Repository
Directory must
be <REMOTE>
(broker is
1Cs)
|OADRetryTimelnterval| A positive number in 10 Dynamic Repository
minutes Directory must
be <REMOTE>
(broker is
1Cs)
IPollEnd Time] HH :MM HH: MM Component
restart
[PollFrequency]| A positive integer in 10000 Dynamic
milliseconds
no (to disable polling)
key (to poll only when
the letter p is entered in
the connector’s
Command Prompt
window)
[PollQuantity| 1-500 1 Agent JMS transport
restart only:
Container
Managed
Events is
specified
[PollStartTime| HH:MM(HH is 0-23, MM is | HH:MM Component
0-59) restart
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Table 23. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
IRepositoryDirectory]| Location of metadata Agent For ICS: set to
repository restart <REMOTE>
For WebSphere
MQ message
brokers and
WAS: set to
C:\crossworlds\
repository
g Queue Valid JMS queue name CONNECTORNAME /REQUESTQUEUE Component | Delivery
restart Transport is
JMS
IResEonseQueug Valid JMS queue name CONNECTORNAME /RESPONSEQUEUE Component | Delivery
restart Transport is
JMS:
required only
if Repository
directory is
<REMOTE>
0-99 3 Dynamic
|RestartRetryIntervall A sensible positive 1 Dynamic
value in minutes:
1 - 2147483547
[RHF2MessageDomain| mrm, xml mrm Component | Only if Delivery
restart Transport is JMS
and WireFormat
is CwXML.
[SourceQueue| Valid WebSphere MQ CONNECTORNAME / SOURCEQUEUE Agent Only if
name restart Delivery
Transport is
JMS and
Container
Managed
Events is
specified
|SynchronousRequestQueue| CONNECTORNAME/ Component | Delivery
SYNCHRONOUSREQUESTQUEUE restart Transport is
JMS
|ISynchronousRequestTimeout| 0 - any number (millisecs) | 0 Component | Delivery
restart Transport is
JMS
|SynchronousResponseQueud CONNECTORNAME/ Component | Delivery
SYNCHRONOUSRESPONSEQUEUE restart Transport is
JMS
CwXML, CwBO CwXML Agent CwXML if
restart Repository
Directory is
not <REMOTE>:
CwBO if
Repository
Directory is
<REMOTE>
rVVsifSVnchronousRequestTimeoutl 0 - any number 0 Component | WAS only
(millisecs) restart
IXMLNameSpaceFormat| short, long short Agent WebSphere MQ
restart message
brokers and
WAS only
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Standard configuration properties

This section lists and defines each of the standard connector configuration
properties.

AdmininQueue

The queue that is used by the integration broker to send administrative messages
to the connector.

The default value is CONNECTORNAME /ADMININQUEUE.

AdminOutQueue

The queue that is used by the connector to send administrative messages to the
integration broker.

The default value is CONNECTORNAME/ADMINOUTQUEUE.

AgentConnections
Applicable only if RepositoryDirectory is <REMOTE>.

The AgentConnections property controls the number of ORB (Object Request
Broker) connections opened by orb.init[].

The default value of this property is set to 1. You can change it as required.

AgentTraceLevel

Level of trace messages for the application-specific component. The default is 0.
The connector delivers all trace messages applicable at the tracing level set or
lower.

ApplicationName

Name that uniquely identifies the connector’s application. This name is used by
the system administrator to monitor the WebSphere business integration system
environment. This property must have a value before you can run the connector.

BrokerType

Identifies the integration broker type that you are using. The options are ICS,
WebSphere message brokers (WMQI, WMQIB or WBIMB) or WAS.

CharacterEncoding

Specifies the character code set used to map from a character (such as a letter of
the alphabet, a numeric representation, or a punctuation mark) to a numeric value.

Note: Java-based connectors do not use this property. A C++ connector currently
uses the value ascii7 for this property.

By default, a subset of supported character encodings only is displayed in the
drop-down list. To add other supported values to the drop-down list, you must
manually modify the \Data\Std\stdConnProps.xml file in the product directory. For
more information, see the appendix on Connector Configurator.
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ConcurrentEventTriggeredFlows
Applicable only if RepositoryDirectory is <REMOTE>.

Determines how many business objects can be concurrently processed by the
connector for event delivery. Set the value of this attribute to the number of
business objects you want concurrently mapped and delivered. For example, set
the value of this property to 5 to cause five business objects to be concurrently
processed. The default value is 1.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), you must:

* Configure the collaboration to use multiple threads by setting its Maximum number
of concurrent events property high enough to use multiple threads.

* Ensure that the destination application’s application-specific component can
process requests concurrently. That is, it must be multi-threaded, or be able to
use connector agent parallelism and be configured for multiple processes. Set the
Parallel Process Degree configuration property to a value greater than 1.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and performed serially.

ContainerManagedEvents

This property allows a JMS-enabled connector with a JMS event store to provide
guaranteed event delivery, in which an event is removed from the source queue
and placed on the destination queue as a single JMS transaction.

There is no default value.

When ContainerManagedEvents is set to JMS, you must configure the following
properties to enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = /SOURCEQUEUE

You must also configure a data handler with the MimeType, DHClass (data
handler class), and DataHandlerConfigMOName (the meta-object name, which is
optional) properties. To set those values, use the Data Handler tab in Connector
Configurator.

Thes properties are adapter-specific, but example values are:
* MimeType = text\xml

* DHClass = com.crossworlds.DataHandlers.text.xml

* DataHandlerConfigMOName = MO_DataHandler_Default

The fields for these values in the Data Handler tab will be displayed only if you
have set ContainerManagedEvents to JMS.
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Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pol1ForEvents() method, thereby disabling that method’s functionality.

This property only appears if the DeliveryTransport property is set to the value
JMS.

ControllerStoreAndForwardMode
Applicable only if RepositoryDirectory is <REMOTE>.

Sets the behavior of the connector controller after it detects that the destination
application-specific component is unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches ICS, the connector controller blocks the request
to the application-specific component. When the application-specific component
becomes operational, the controller forwards the request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific
component is unavailable.

The default is true.

ControllerTraceLevel
Applicable only if RepositoryDirectory is <REMOTE>.

Level of trace messages for the connector controller. The default is 0.

DeliveryQueue
Applicable only if DeliveryTransport is JMS.

The queue that is used by the connector to send business objects to the integration
broker.

The default value is CONNECTORNAME/DELIVERYQUEUE.

DeliveryTransport

Specifies the transport mechanism for the delivery of events. Possible values are MQ
for WebSphere MQ, IDL for CORBA IIOP, or JMS for Java Messaging Service.

» If the RepositoryDirectory is remote, the value of the DeliveryTransport
property can be MQ, IDL, or JMS, and the default is IDL.

* If the RepositoryDirectory is a local directory, the value may only be JMS.

The connector sends service call requests and administrative messages over
CORBA 1IIOP if the value configured for the DeliveryTransport property is MQ or
IDL.

WebSphere MQ and IDL

Use WebSphere MQ rather than IDL for event delivery transport, unless you must
have only one product. WebSphere MQ offers the following advantages over IDL:
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* Asynchronous communication:
WebSphere MQ allows the application-specific component to poll and
persistently store events even when the server is not available.

* Server side performance:
WebSphere MQ provides faster performance on the server side. In optimized
mode, WebSphere MQ stores only the pointer to an event in the repository
database, while the actual event remains in the WebSphere MQ queue. This
saves having to write potentially large events to the repository database.

* Agent side performance:
WebSphere MQ provides faster performance on the application-specific
component side. Using WebSphere MQ, the connector’s polling thread picks up
an event, places it in the connector’s queue, then picks up the next event. This is
faster than IDL, which requires the connector’s polling thread to pick up an
event, go over the network into the server process, store the event persistently in
the repository database, then pick up the next event.

JMS

Enables communication between the connector and client connector framework
using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as

Jjms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName,
appear in Connector Configurator. The first two of these properties are required for
this transport.

Important: There may be a memory limitation if you use the JMS transport
mechanism for a connector in the following environment:

s AIX5.0
* WebSphere MQ 5.3.0.1
* When ICS is the integration broker

In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client. If your installation uses less than 768M of
process heap size, IBM recommends that you set:

e The LDR_CNTRL environment variable in the CWSharedEnv.sh script.

This script resides in the \bin directory below the product directory. With a text
editor, add the following line as the first line in the CWSharedEnv.sh script:

export LDR_CNTRL=MAXDATA=0x30000000

This line restricts heap memory usage to a maximum of 768 MB (3 segments *
256 MB). If the process memory grows more than this limit, page swapping can
occur, which can adversely affect the performance of your system.

e The IPCCBaseAddress property to a value of 11 or 12. For more information on
this property, see the System Installation Guide for UNIX.

DuplicateEventElimination

When you set this property to true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, the
connector must have a unique event identifier set as the business object’s
ObjectEventld attribute in the application-specific code. This is done during
connector development.

This property can also be set to false.
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Note: When DuplicateEventElimination is set to true, you must also configure
the MonitorQueue property to enable guaranteed event delivery.

FaultQueue

If the connector experiences an error while processing a message then the
connector moves the message to the queue specified in this property, along with a
status indicator and a description of the problem.

The default value is CONNECTORNAME/FAULTQUEUE.

JvmMaxHeapSize

The maximum heap size for the agent (in megabytes). This property is applicable
only if the RepositoryDirectory value is <REMOTE>.

The default value is 128m.

JvmMaxNativeStackSize

The maximum native stack size for the agent (in kilobytes). This property is
applicable only if the RepositoryDirectory value is <REMOTE>.

The default value is 128k.

JvmMinHeapSize

The minimum heap size for the agent (in megabytes). This property is applicable
only if the RepositoryDirectory value is <REMOTE>.

The default value is 1m.

jms.FactoryClassName

Specifies the class name to instantiate for a JMS provider. You must set this
connector property when you choose JMS as your delivery transport mechanism
(DeliveryTransport).

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.MessageBrokerName

Specifies the broker name to use for the JMS provider. You must set this connector
property when you choose JMS as your delivery transport mechanism
(DeliveryTransport).

The default is crossworlds.queue.manager. Use the default when connecting to a
local message broker.

When you connect to a remote message broker, this property takes the following
(mandatory) values:

QueueMgrName:<Channel>:<HostName>:<PortNumber>,

where the variables are:

QueueMgrName: The name of the queue manager.

Channel: The channel used by the client.

HostName: The name of the machine where the queue manager is to reside.
PortNumber: The port number to be used by the queue manager for listening.
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For example:
jms .MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

jms.NumConcurrentRequests

Specifies the maximum number of concurrent service call requests that can be sent
to a connector at the same time. Once that maximum is reached, new service calls
block and wait for another request to complete before proceeding.

The default value is 10.

jms.Password
Specifies the password for the JMS provider. A value for this property is optional.

There is no default.

jms.UserName

Specifies the user name for the JMS provider. A value for this property is optional.

There is no default.

ListenerConcurrency

This property supports multi-threading in MQ Listener when ICS is the integration
broker. It enables batch writing of multiple events to the database, thus improving
system performance. The default value is 1.

This property applies only to connectors using MQ transport. The
DeliveryTransport property must be set to MQ.

Locale

Specifies the language code, country or territory, and, optionally, the associated
character code set. The value of this property determines such cultural conventions
as collation and sort order of data, date and time formats, and the symbols used in
monetary specifications.

A locale name has the following format:
U1 _TT.codeset

where:

Il a two-character language code (usually in lower
case)

T a two-letter country or territory code (usually in
upper case)

codeset the name of the associated character code set; this

portion of the name is often optional.

By default, only a subset of supported locales appears in the drop-down list. To
add other supported values to the drop-down list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
see the appendix on Connector Configurator.
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The default value is en_US. If the connector has not been globalized, the only valid
value for this property is en_US. To determine whether a specific connector has
been globalized, see the connector version list on these websites:

http:/ /www.ibm.com/software/websphere/wbiadapters/infocenter, or
http:/ /www.ibm.com /websphere/integration/wicserver/infocenter

LogAtinterchangeEnd
Applicable only if RespositoryDirectory is <REMOTE>.

Specifies whether to log errors to the integration broker’s log destination. Logging
to the broker’s log destination also turns on e-mail notification, which generates
e-mail messages for the MESSAGE_RECIPIENT specified in the InterchangeSystem.cfg
file when errors or fatal errors occur.

For example, when a connector loses its connection to its application, if
LogAtInterChangeEnd is set to true, an e-mail message is sent to the specified
message recipient. The default is false.

MaxEventCapacity

The maximum number of events in the controller buffer. This property is used by
flow control and is applicable only if the value of the RepositoryDirectory
property is <REMOTE>.

The value can be a positive integer between 1 and 2147483647. The default value is
2147483647.

MessageFileName

The name of the connector message file. The standard location for the message file
is \connectors\messages in the product directory. Specify the message filename in
an absolute path if the message file is not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a specific connector has its own message file, see the
individual adapter user guide.

MonitorQueue

The logical queue that the connector uses to monitor duplicate events. It is used
only if the DeliveryTransport property value is JMS and
DupTicateEventETimination is set to TRUE.

The default value is CONNECTORNAME/MONITORQUEUE

OADAutoRestartAgent
Valid only when the RepositoryDirectory is <REMOTE>.

Specifies whether the connector uses the automatic and remote restart feature. This
feature uses the MQ-triggered Object Activation Daemon (OAD) to restart the
connector after an abnormal shutdown, or to start a remote connector from System
Monitor.
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This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the MQ-triggered OAD feature. see
the Installation Guide for Windows or for UNIX.

The default value is false.

OADMaxNumRetry
Valid only when the RepositoryDirectory is <REMOTE>.

Specifies the maximum number of times that the MQ-triggered OAD automatically
attempts to restart the connector after an abnormal shutdown. The
OADAutoRestartAgent property must be set to true for this property to take effect.

The default value is 1000.

OADRetryTimelnterval
Valid only when the RepositoryDirectory is <REMOTE>.

Specifies the number of minutes in the retry-time interval for the MQ-triggered
OAD. If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this property
to take effect.

The default is 10.

PollEndTime

Time to stop polling the event queue. The format is HH:MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

PollFrequency

This is the interval between the end of the last poll and the start of the next poll.
Pol1Frequency specifies the amount of time (in milliseconds) between the end of

one polling action, and the start of the next polling action. This is not the interval
between polling actions. Rather, the logic is as follows:

* Poll to obtain the number of objects specified by the value of Pol1Quantity.

* Process these objects. For some adapters, this may be partly done on separate
threads, which execute asynchronously to the next polling action.

* Delay for the interval specified by Pol1Frequency.
* Repeat the cycle.

Set Pol1Frequency to one of the following values:
* The number of milliseconds between polling actions (an integer).

* The word key, which causes the connector to poll only when you type the letter
p in the connector’s Command Prompt window. Enter the word in lowercase.

* The word no, which causes the connector not to poll. Enter the word in
lowercase.
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The default is 10000.

Important: Some connectors have restrictions on the use of this property. Where
they exist, these restrictions are documented in the chapter on
installing and configuring the adapter.

PollQuantity

Designates the number of items from the application that the connector should poll
for. If the adapter has a connector-specific property for setting the poll quantity, the
value set in the connector-specific property will override the standard property
value.

FIX

An email message is also considerd an event. The connector behaves as follows
when it is polled for email.

Polled once - connector goes to pick 1. the body of the message as it is also
considered an attachment also. Since no DH was specified for this mime type, it it
will ignore the body. 2. conector process first PO attachment. DH is avaiable for
this mime type so it sends the business object to the Visual Test Connector. If the 3.
accept in VIC again no BO should come thru Polled second time 1. conector
process second PO attachment. DH is avaiable for this mime type so it sends teh
BO to VTC2. accept in VTC again now the third PO attachment should come
through. This is the correct behaviour.

PollStartTime

The time to start polling the event queue. The format is HH: MV, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

RequestQueue

The queue that is used by the integration broker to send business objects to the
connector.

The default value is CONNECTOR/REQUESTQUEUE.

RepositoryDirectory

The location of the repository from which the connector reads the XML schema
documents that store the meta-data for business object definitions.

When the integration broker is ICS, this value must be set to <REMOTE> because
the connector obtains this information from the InterChange Server repository.

When the integration broker is a WebSphere message broker or WAS, this value
must be set to <local directory>.

ResponseQueue

Applicable only if DeliveryTransport is JMS and required only if
RepositoryDirectory is <REMOTE>.
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Designates the JMS response queue, which delivers a response message from the
connector framework to the integration broker. When the integration broker is ICS,
the server sends the request and waits for a response message in the JMS response
queue.

RestartRetryCount

Specifies the number of times the connector attempts to restart itself. When used
for a parallel connector, specifies the number of times the master connector
application-specific component attempts to restart the slave connector
application-specific component.

The default is 3.

RestartRetrylnterval

Specifies the interval in minutes at which the connector attempts to restart itself.
When used for a parallel connector, specifies the interval at which the master
connector application-specific component attempts to restart the slave connector
application-specific component. Possible values ranges from 1 to 2147483647.

The default is 1.

RHF2MessageDomain
WebSphere message brokers and WAS only.

This property allows you to configure the value of the field domain name in the
JMS header. When data is sent to WMQI over JMS transport, the adapter
framework writes JMS header information, with a domain name and a fixed value
of mrm. A connfigurable domain name enables users to track how the WMQI broker
processes the message data.

A sample header would look like this:

<mcd><Msd>mrm</Msd><Set>3</Set><Type>
Retek_POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

The default value is mrm, but it may also be set to xm1. This property only appears
when DeliveryTransport is set to JMSand WireFormat is set to CwXML.

SourceQueue

Applicable only if DeliveryTransport is JMS and ContainerManagedEvents is
specified.

Designates the JMS source queue for the connector framework in support of
guaranteed event delivery for JMS-enabled connectors that use a JMS event store.
For further information, see [“ContainerManagedEvents” on page 70

The default value is CONNECTOR/SOURCEQUEUE.

SynchronousRequestQueue
Applicable only if DeTiveryTransport is JMS.

Delivers request messages that require a synchronous response from the connector

framework to the broker. This queue is necessary only if the connector uses
synchronous execution. With synchronous execution, the connector framework
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sends a message to the SynchronousRequestQueue and waits for a response back
from the broker on the SynchronousResponseQueue. The response message sent to
the connector bears a correlation ID that matches the ID of the original message.

The default is CONNECTORNAME/SYNCHRONOUSREQUESTQUEUE

SynchronousResponseQueue
Applicable only if DeliveryTransport is JMS.

Delivers response messages sent in reply to a synchronous request from the broker
to the connector framework. This queue is necessary only if the connector uses
synchronous execution.

The default is CONNECTORNAME/SYNCHRONOUSRESPONSEQUEUE

SynchronousRequestTimeout
Applicable only if DeliveryTransport is JMS.

Specifies the time in minutes that the connector waits for a response to a
synchronous request. If the response is not received within the specified time, then
the connector moves the original synchronous request message into the fault queue
along with an error message.

The default value is 0.

WireFormat

Message format on the transport.
* If the RepositoryDirectory is a local directory, the setting is CwXML.
e If the value of RepositoryDirectory is <REMOTE>, the setting isCwBO.

WsifSynchronousRequestTimeout
WAS integration broker only.
Specifies the time in minutes that the connector waits for a response to a
synchronous request. If the response is not received within the specified, time then
the connector moves the original synchronous request message into the fault queue

along with an error message.

The default value is 0.

XMLNameSpaceFormat
WebSphere message brokers and WAS integration broker only.

A strong property that allows the user to specify short and long name spaces in
the XML format of business object definitions.

The default value is short.
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Appendix B. Connector-specific properties for the WBI
Message Broker adapter

This appendix describes connector-specific properties for the adapter for
WebSphere Business Integration Message Broker. Refer to these properties when
using Connector Configurator to configure the adapter.

Overview of connector-specific properties

Connector-specific configuration properties provide information needed by the
connector agent at runtime. Connector-specific properties also provide a way of
changing static information or logic within the connector agent without having to
recode and rebuild the agent.

Connector-specific properties
First Paragraph

lists the connector-specific configuration properties for the connector. See
the sections that follow for explanations of the properties.
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Table 24. Connector-specific configuration properties

Name Possible values Default value Required

ApplicationPassword| Login password No

[ApplicationUserName| Login user ID No

ArchiveQueue| Queue to which copies of successfully ~ MQWFCONN.ARCHIVE No
processed messages are sent

Character set for queue manager null Yes
connection

Channe| MQ server connector channel Yes

ConfigurationMetaObject] Name of configuration meta-object Yes

[DataHandlerClassName] Data handler class name com.crossworlds.DataHandlers. Yes

text.xml

DataHandlerConfigM Data handler meta-object MO_DataHandler_Default Yes

DataHandlerMimeType MIME type of file text/xml No

DefaultVerb] Any verb supported by the connector. Create

[EnableMessageProducerCache|true or false true No
Queue for unprocessed messages MQWFCONN. ERROR No
WebSphere MQ server No
FailOnStartup Reprocess Reprocess No
IgnoreLogError
Poll queue MQWFCONN. IN Yes
In-progress event queue MQWFCONN. IN_PROGRESS No
Number of messages to retrieve from 1 No
each queue specified in the InputQueue
property

Port Port established for the WebSphere MQ No
listener

Queue to which response messages are  MQWFCONN.REPLYTO No
delivered when the connector issues
requests

[SessionPoolSizeForRequests| ~ Maximum pool size for caching the 10 No
sessions used during request processing

[UnsubscribedQueus| Queue to which unsubscribed messages  MQWFCONN.UNSUBSCRIBED No
are sent

true or false false

ApplicationPassword

Password used with UserID to log in to WebSphere Business Integration Message
Broker.

Default = None.

If the AppTlicationPassword is left blank or removed, the connector uses the default
password provided by WebSphere Business Integration Message Broker.

ApplicationUserName

User ID used with Password to log in to WebSphere Business Integration Message
Broker.

Default = None.

If the ApplicationUserName is left blank or removed, the connector uses the default
user ID provided by WebSphere Business Integration Message Broker.
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ArchiveQueue

Queue to which copies of successfully processed messages are sent.

Default = MQWFCONN. ARCHIVE
CCsID

The character set for the queue manager connection. The value of this propert
should match that of the CCSID property in the queue URIL. See

[Uniform Resource Identifiers (URI)” on page 33/

Default = null.

Channel

MQ server connector channel through which the connector communicates with
WebSphere Business Integration Message Broker.

Default = none.

If the Channel is left blank or removed, the connector uses the default server
channel provided by WebSphere Business Integration Message Broker.

ConfigurationMetaObject

Name of meta-object containing configuration information for the connector

Default = none.

DataHandlerClassName

Data handler class to use when converting messages to and from business objects.

Default = com.crossworlds.DataHandlers.text.xml

DataHandlerConfigMO

Meta-object passed to data handler to provide configuration information.

Default = MO_DataHandler_Default

DataHandlerMimeType
Allows you to request a data handler based on a particular MIME type.

Default = text/xm1

DefaultVerb

Specifies the verb to be set within an incoming business object, if it has not been
set by the data handler during polling.

Default= Create

EnableMessageProducerCache

Boolean property to specify that the adapter should enable a message producer
cache for sending request messages.
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Default= true

ErrorQueue

Queue to which messages that could not be processed are sent.

Default = queue://CrossWorlds.QueueManager/ERROR

HostName

The name of the server hosting WebSphere Business Integration Message Broker.

Default = none.

InDoubtEvents

Specifies how to handle in-progress events that are not fully processed due to
unexpected connector shutdown. Choose one of four actions to take if events are
found in the in-progress queue during initialization:

* FailOnStartup. Log an error and immediately shut down.

* Reprocess. Process the remaining events first, then process messages in the
input queue.

* Ignore. Disregard any messages in the in-progress queue.

* LogError. Log an error but do not shut down

Default = Reprocess.

InputQueue

Message queues that will be polled by the connector for new messages. The
connector accepts multiple semi-colon delimited queue names. For example, to poll
the following three queues: MyQueueA, MyQueueB, and MyQueueC, the value for
connector configuration property InputQueue would equal:
MyQueueA;MyQueueB;MyQueueC.

The connector polls the queues in a round-robin manner and retrieves up to
pol1Quantity number of messages from each queue. For example, if pollQuantity
equals 2, and MyQueueA contains 2 messages, MyQueueB contains 1 message and
MyQueueC contains 5 messages, the connector retrieves messages in the following
manner:

Since we have a pollQuanity of 2, the connector will retrieve at most 2 messages
from each queue per call to pollForEvents. For the first cycle (1 of 2), the connector
retrieves the first message from each of MyQueueA, MyQueueB, and MyQueueC.
That completes the first round of polling and if we had a pollQuantity of 1, the
connector would stop. Since we have a pollQuanity of 2, the connector starts a
second round of polling (2 of 2) and retrieves one message each from MyQueueA
and MyQueueC--it skips MqQueueB since it is now empty. After polling all queues
2x each, the call to the method pollForEvents is complete. Here’s the sequence of
message retrieval:

1. 1 message from MyQueueA
1 message from MyQueueB
1 message from MyQueueC
1 message from MyQueueA

Al A

Skip MyQueueB since it’s now empty
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6. 1 message from MyQueueC

Default = queue://CrossWorlds.QueueManager/IN

InProgressQueue

Message queue where messages are held during processing. You can configure the
connector to operate without this queue by using System Manager to remove the
default InProgressQueue name from the connector-specific properties. Doing so
prompts a warning at startup that event delivery may be compromised if the
connector is shut down while are events pending.

Default= queue://CrossWorlds.QueueManaer/IN_PROGRESS

PollQuantity

Number of messages to retrieve from each queue specified in the InputQueue
property during a pol1ForEvents scan.

Default =1

Port

Port established for the WebSphere Business Integration Message Broker listener.

Default = None.

ReplyToQueue

Queue to which response messages are delivered when the connector issues
requests.

Default = queue://CrossWorlds.QueueManager/REPLYTO

SessionPoolSizeForRequests
Maximum pool size for caching the sessions used during request processing.

Default = 10

UnsubscribedQueue

Queue to which messages that are not subscribed are sent.
Default = queue://CrossWorlds.QueueManager/UNSUBSCRIBED

Note: *Always check the values WebSphere Business Integration Message Broker
provides since they may be incorrect or unknown. If so, please implicitly
specify values.

UseDefaults

On a Create operation, if UseDefaults is set to true, the connector checks whether
a valid value or a default value is provided for each isRequired business object
attribute. If a value is provided, the Create operation succeeds. If the parameter is
set to false, the connector checks only for a valid value and causes the Create
operation to fail if it is not provided. The default is false.
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Appendix C. Tutorial

“Overview of the tutorial’

+ [“Before you begin” on page 8§

* |“Setting up your environment” on page 88|

* [“Running the scenarios” on page 91|

This tutorial is designed to show you the following:

* How the Adapter for WebSphere Business Integration Message Broker can be
integrated with WebSphere Business Integration Message Broker’s message
flows.

* How the adapter sends and receives messages to and from a legacy application.

The tutorial’s scenarios are designed to show the basic points of the adapter’s
functionality.

See the Preface of this document for a guide to notational conventions.

Overview of the tutorial

The tutorial involves a legacy application (simulated, using a utility) that sends an
XML message to the adapter via a message broker. The message conveys changes
in the status of various catalog items. In place of the data warehousing flows and
message conversions associated with WebSphere Business Integration Message
Broker, the legacy message instead passes through a simple color-check flow. Then
the message is sent to the adapter.

The adapter receives the color-processed message from the WBI Message Broker.
Using the XML data handler, the adapter converts the message into business object
Sample_WBIMB_LegacyItem_XMLDoc and passes this object to the integration broker.
In the tutorial, you simulate the Port connector (using the Visual Test Connector),
retrieve the newly created business object, and confirm its contents.

In the opposite direction, you issue the business object from the Visual Test
Connector. The Adapter for WBI Message Broker converts the object to a legacy
message. The adapter delivers the message to the WebSphere Business Integration
Message Broker application where it is processed (its message format is updated to
LI_UP) and redirected to the (simulated) legacy application. This scenario is
demonstrated with the adapter configured for WMQI.

Everything you need to run this scenario is installed with the adapter and adapter

framework:

* The WebSphere Business Integration Message Broker projects (Message Flow
project and Server project) that contain the sample message flows, sample
domain configuration manager file, and a deployable bar file.

* The Port connector repository and Visual Test Connector (included with
installation of the ADK). The Port Connector is comprised of an adapter
definition with no underlying code and as such is well-suited for simulation
scenarios. The Visual Test Connector is a tool for testing interfaces.

In this appendix

This appendix covers the following tasks:
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Table 25. Demonstrating the adapter: task roadmap

Task Associated procedure (see...)
Reviewing an installation checklist [“Before you begin”|

Setting up your environment [“Setting up your environment”|
Running the scenarios ['Running the scenarios” on page 91|

Before you begin

Before proceeding with this tutorial, make sure that you have performed the
following tasks:

* You installed and are experienced with the IBM WebSphere product.

* You installed WebSphere MQ 5.1 or later.

* You installed WebSphere Business Integration Message Broker 5.0 or later.
* You installed the WebSphere MQ client libraries for Java.

* You installed the Adapter for WebSphere Business Integration Message Broker
(configuration instructions are provided in this tutorial).

* Your WebSphere MQ adapter queue manager is named
crossworlds.queue.manager(the default value during installation). Otherwise,
substitute your queue manager name whenever this document refers to
crossworlds.queue.manager In addition, you must do the following;:

1. Open the Message Brokers Toolkit and change the QueueManagerName
attribute of all MQOutput nodes in the sample message flows to
crossworlds.queue.manager.

2. Open the LocalDomain.configmgr file in the server project (this project is in
the samples you installed with the adapter) and then change the queue
manager name (that your broker is configured for) to
crossworlds.queue.manager.

3. Open Business Object Designer and change the output queue manager
specified in sample meta-object Sample_WBIMB_MO_Config
to crossworlds.queue.manager

* You performed a full installation (not the basic installation) of WebSphere MQ,
including WebSphere MQ explorer. Although not necessary, WebSphere MQ
explorer makes it easier to establish queues and examine messages.

* You installed the WebSphere MQ client libraries for Java.

Setting up your environment

This topic contains an overview and procedure for setting up your environment.

Overview of setting up your environment

This section describes how to prepare your environment to work with the tutorial.
In what follows, sample_folder refers to the samples/Legacy Item folder in the
installed file structure. For further information, see [“Verifying installation” on page|
The business object repository is provided in the sample_folder as .xsd files.

The tutorial depicts a simple business object exchange between the WebSphere
Business Integration Message Broker adapter and the Visual Test Connector. The
exchange occurs in a WebSphere Business Integration Message Broker
environment.

88 Adapter for WebSphere Business Integration Message Broker User Guide



Steps for setting up your environment

To set up for the tutorial, please configure the following:

1.

Define the queues The tutorial requires that eight queues be defined in your

queue manager. To create the necessary queues, type RUNMQSC from a command

line and issue the following commands:

e DEFINE QL('Samples/WBIMB/Item/LegacyApp')

* DEFINE QL('Samples/WBIMB/Item/WBIMBConnector')

e DEFINE QL('Samples/LegacyApp/Item/WBIMB')

e DEFINE QL('Samples/WBIMBConnector/Item/WBIMB')

« DEFINE QL('Samples/WBIMB/FAIL')

e DEFINE QL('Samples/WBIMBConnector/UNSUBSCRIBED')
e DEFINE QL('Samples/WBIMBConnector/ERROR")

e DEFINE QL('Samples/WBIMBConnector/ARCHIVE")

Next you define the queues required by the WBI Message Broker adapter and

Port Connector for the WBI Message Broker configuration as follows:
« DEFINE QL('WBIMBConnector/ADMININQUEUE')

e DEFINE QL('WBIMBConnector/ADMINOUTQUEUE")

e DEFINE QL('WBIMBConnector/DELIVERYQUEUE")

e DEFINE QL('WBIMBConnector/FAULTQUEUE')

e DEFINE QL('WBIMBConnector/REQUESTQUEUE")

« DEFINE QL('WBIMBConnector/RESPONSEQUEUE')

e DEFINE QL('WBIMBConnector/SYNCHRONOUSREQUESTQUEUE')
e DEFINE QL('WBIMBConnectorSYNCHRONOUSRESPONSEQUEUE')
« DEFINE QL('WBIMBConnectorMONITORQUEUE')

e DEFINE QL('PortConnector/ADMININQUEUE")

e DEFINE QL('PortConnector/ADMINOUTQUEUE")

* DEFINE QL('PortConnector/DELIVERYQUEUE')

e DEFINE QL('PortConnector/FAULTQUEUE")

e DEFINE QL('PortConnector/REQUESTQUEUE")

e DEFINE QL('PortConnector/RESPONSEQUEUE")

e DEFINE QL('PortConnector/SYNCHRONOUSREQUESTQUEUE")
e DEFINE QL('PortConnector/SYNCHRONOUSRESPONSEQUEUE")

Configure the adapter Using Connector Configurator, select

File->Open->From File and load the WBIMBConnector.cfg in the sample_folder.

Check or change the adapter configuration properties to match the values listed
below. For further information on using Connector Configurator, see|Chapter 6

|”C0nﬁguring a data handler,” on page 57 for more on connector-specific

properties, see|Appendix B, “Connector-specific properties for the WBI Message]

[Broker adapter,” on page 81
Set the following standard properties:

* Broker Type Set this property to WMQI.

* Repository Directory Set this property to the sample_folder directory.
* DuplicateEventElimination Set this property to true.

* MonitorQueue Set this property to WBIMBConnector/MONITORQUEUE

. Set the following connector-specific properties:
¢ ConfigurationMetaObject Set this property to Sample WBIMB_MO Config.
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* DataHandlerConfigMO Set this property to Sample_WBIMB_MO_DataHandler.
* DataHandlerMimeType Set this property to text/xml.

e ErrorQueue Set this property to
queue://crossworlds.queue.manager/Samples/WBIMBConnector/ERROR.

* InputQueue Set this property to
queue://crossworlds.queue.manager/Samples/WBIMB/Item/WBIMBConnector.

* UnsubscribedQueue Set this property to
queue://crossworlds.queue.manager/Samples/WBIMBConnector/UNSUBSCRIBED.

* ArchiveQueue Set this property to
queue://crossworlds.queue.manager/Samples/WBIMBConnector/ARCHIVE

3. Configure the Port Connector Using Connector Configurator, set the following

standard properties:

* Broker Type Set this property to WMQI.

* Repository Directory Set this property to the sample_folder directory.

* RequestQueue Set this property to WBIMBConnector/DELIVERYQUEUE (the
DeliveryQueue property value for the WBI Message Broker adapter).

* DeliveryQueue Set this property to WBIMBConnector/REQUESTQUEUE (the
RequestQueue property value for the WBI Message Broker adapter).

4. Configure supported business objects In order to use business objects,
adapters must first support them. Using Connector Configurator, click the
Supported Business Objects tab for the WBI Message Broker adapter, add the
business objects shown in and set the Message Set ID to a unique
value for each supported business object.

Table 26. Supported sample business objects for JMS adapter

Business object name Message ID
SampTle_WBIMB_MO_Config 1
SampTe_WBIMB_MO_DataHandler 2
Sample_WBIMB_LegacyItem 3
SampTe_WBIMB_ LegacyItem XMLDoc 4

Using Connector Configurator, open the Port connector definition
PortConnector.cfg provided in the sample_folder, and add the supported
business objects and Message IDs shown in

Table 27. Supported sample business objects for Port connector

Business object name Message ID
Sample WBIMB LegacyItem 1
SampTe_WBIMB_LegacyItem_XMLDoc 2

5. Create a new message flow project

a. Open the Message Brokers Toolkit and create a new Message Flow Project.
Import all the message flows and ESQL files from the
sample_folder /MSG_FLOW_PROJECT directory to your Message Flow Project.

b. Create a new Server Project and import all the files from the
sample_folder/Sample_WBIMB_Project to your server project.

c. Connect to the domain displayed under the Domains view in your Broker
Administration perspective. Deploy the bar file Sample_WBIMB_bar.bar from
the Broker Administration Navigator panel in your Broker Administration
perspective to the default execution group of your broker.
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6. Configure connector start scripts
Windows:

a. Open the properties of the shortcut for the adapter for WBI Message Broker.

b. As the last argument in the target, add -c followed by the <full path and
filename for the WBIMBConnector.cfg file> For example:

-cProduct_Dir\connectors\WBIMB\LegacyItem\
WBIMBConnector.cfg

UNIX:

a. Open the file:
Product_Dir/bin/connector_manager _WebSphereBusinessIntegrationMessageBroker.
Set the value of the AGENTCONFIG_FILE property to -c followed by the <full
path and filename for the WBIMBConnector.cfg file>. For example:

AGENTCONFIG_FILE=-cProduct_Dir/connectors/WebSphereBusinessIntegrationMessageBroker
/samples/LegacyItem/WBIMBConnector.cfg

Running the scenarios

This topic contains an overview and procedures for running the scenarios.

Overview of running the scenarios

The tutorial includes a request processing and an event processing scenario. To run
the scenarios, you must configure the samples as described in [‘Setting up your|
fenvironment” on page 88

Steps for running the scenarios
To run the scenarios, do the following:

1. Start the Adapter for WebSphere Business Integration Message Broker if it is
not already running. For further information, see|“Starting the connector” on|

2. Start the Visual Test Connector if it is not already running. For further
information, see Implementing Adapters with WebSphere Message Brokers.

3. Start the WebSphere Business Integration Message Broker application broker
if not already running.For further information, see Implementing Adapters with
WebSphere Message Brokers.

4. Simulate the Port connector Using Visual Test Connector, define a profile for
the Port connector:

a. Select File->Create/Select Profile from the Visual Test Connector menu,
then select File-> New Profile from the Connector Profile menu.

b. Select the Port Connector configuration file PortConnector.cfg in the
sample_folder, then configure the Connector Name and Broker Type and click
OK.

C. Select the profile you created and click OK.
5. Test the request processing scenario Using Visual Test Connector, create a
new instance of a business object and send it:

a. Create a new instance of business object Sample_WBIMB_LegacyItem XMLDoc
by selecting the business object in the BoType drop-down box and then
selecting Create for the BOInstance. This business object is merely an XML
wrapper required by the XML data handler; you will need to create a new
instance of child-object Legacyltem in your test object to contain actual
data. Change the default values if desired

b. Send the message by clicking Send BO.
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6. Confirm message delivery Using WebSphere MQ Explorer or a similar
application, open queue
queue://crossworlds.queue.manager/Samples/WBIMB/Item/LegacyApp to see if a
new legacy item message with format LI_UP has arrived from the adapter. This
indicates a successful delivery of the business object payload as a legacy
message via the WebSphere Business Integration Message Broker application. If
no message can be found, check in queue
queue://crossworlds.queue.manager/Samples/WBIMB/FAIL to see if the message
could not be processed by the WebSphere Business Integration Message Broker
application. If this is the case, see Implementing Adapters with WebSphere Message
Brokers to enable tracing. Then you can determine where the error occurred in
the WebSphere Business Integration Message Broker application.

7. Test the event processing scenario Use utility sample_folder\mqsiput.exe to
deliver a legacy item message to the adapter via the WebSphere Business
Integration Message Broker application. The mgsiput utility has the following
syntax:
mgsiput [queue] [queue manager] < [message file].

The sample delivery message LegacyItem.txt resides in the sample_folder
directory. For this tutorial, enter

mgsiput Samples/LegacyApp/Item/WBIMB crossworlds.queue.manager <
Legacyltem.txt

at the command line. If successful, a sample item message is delivered to the
WebSphere Business Integration Message Broker application that is simulating a
legacy application.

Note: Optionally you may add the loopback message flow to your broker
execution group. (This flow is provided with the IBM WebSphere
Business Integration Message Broker adapter sample message flows.)
Adding the loopback message flow will loop any message sent from the
adapter back to the adapter after being processed by the WebSphere
Business Integration Message Broker application.

Once the WebSphere Business Integration Message Broker application delivers a

message to the input queue, the adapter retrieves it and attempts to convert it

into a Sample_WBIMB_LegacyItem XMLDoc business object. The key to having the
adapter poll the message is to ensure that the message format equals the value
associated with the Sample_WBIMB_LegacyItem XMLDoc business object in
meta-object Sample_WBIMB_MO_Config. If it identifies the message format as

LI_UP, the adapter then calls the data handler to convert the message to

business object Sample_WBIMB_LegacyItem_XMLDoc with verb Update. The newly

created business object is subsequently delivered to the WBI Broker and then
re-delivered to the Visual Test Connector.

8. Confirm message delivery If you've performed all the above steps successfully,
you should have a working scenario that enables the WBI Message Broker
adapter to retrieve messages and convert them to SampTe_WBIMB_LegacyContact
business objects, and to convert Sample_WBIMB_LegacyContact business objects
to messages.
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Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Burlingame Laboratory Director
IBM Burlingame Laboratory
577 Airport Blvd., Suite 800
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Burlingame, CA 94010
US.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not necessarily tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information may contain examples of data and reports used in daily business

operations. To illustrate them as completely as possible, the examples may include

the names of individuals, companies, brands, and products. All of these names are

fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

COPYRIGHT LICENSE

This information may contain sample application programs in source language,
which illustrates programming techniques on various operating platforms. You
may copy, modify, and distribute these sample programs in any form without
payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the
operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. IBM, therefore, cannot
guarantee or imply reliability, serviceability, or function of these programs.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:

IBM

the IBM logo
AIX
CrossWorlds
DB2

DB2 Universal Database
Domino
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Lotus Notes
MQIntegrator
MQSeries
Tivoli
WebSphere

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of
others.
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